
i-Cut Preflight

User Manual



i-Cut Preflight

ii

Contents

1. Introduction.....................................................................................................................................................................................9

1.1 Licensing............................................................................................................................................................................... 9

1.2 About i-cut Preflight......................................................................................................................................................... 9

1.3 The Reference Manual.................................................................................................................................................... 9

2. Files..................................................................................................................................................................................................12

2.1 New.......................................................................................................................................................................................12

2.1.1 Page Size...............................................................................................................................................................12

2.1.2 Colors......................................................................................................................................................................12

2.2 Open.....................................................................................................................................................................................12

2.3 Open Recent.....................................................................................................................................................................13

2.4 Close.................................................................................................................................................................................... 13

2.5 Save......................................................................................................................................................................................13

2.5.1 Saving a New Document................................................................................................................................ 13

2.5.2 Saving an Existing Document.......................................................................................................................14

2.5.3 Saving a Certified PDF Document.............................................................................................................. 14

2.5.4 Backup....................................................................................................................................................................14

2.6 Save As...............................................................................................................................................................................14

2.7 Save and Preflight.......................................................................................................................................................... 15

2.8 Revert to Saved...............................................................................................................................................................15

2.9 Page Setup........................................................................................................................................................................15

2.10 Print.................................................................................................................................................................................... 16

2.10.1 Printing to Pdf...................................................................................................................................................16

2.10.2 Printing to a Device (Printer Driver)..........................................................................................................17

3. Viewing........................................................................................................................................................................................... 18

3.1 The i-cut Preflight Workspace................................................................................................................................... 18

3.1.1 Tool Bar.................................................................................................................................................................. 19

3.1.2 Navigation Bar.....................................................................................................................................................20

3.1.3 Palette Magnetism............................................................................................................................................. 21

3.1.4 Show / Hide Palettes........................................................................................................................................21

3.2 Views.................................................................................................................................................................................... 21

3.2.1 New View...............................................................................................................................................................21

3.2.2 Switch Views........................................................................................................................................................21

3.2.3 Tile Views...............................................................................................................................................................21

3.2.4 Synchronize Views............................................................................................................................................. 22

3.2.5 View Options Window...................................................................................................................................... 22

3.2.6 View Separations Window..............................................................................................................................26

3.2.7 View Page Boxes Window............................................................................................................................. 27

3.3 Navigating in a File........................................................................................................................................................ 28



Contents

iii

3.3.1 Zooming................................................................................................................................................................. 28

3.3.2 Panning...................................................................................................................................................................30

3.3.3 Navigation Window............................................................................................................................................30

3.3.4 Page Browsing.................................................................................................................................................... 31

3.4 Checking.............................................................................................................................................................................31

3.4.1 Densitometer Tool.............................................................................................................................................. 31

3.4.2 Measure Tool........................................................................................................................................................32

3.4.3 Object / Selection Size.....................................................................................................................................32

3.4.4 Errors & Warnings.............................................................................................................................................. 32

3.4.5 PitStop Report Information............................................................................................................................ 37

3.4.6 File Differences....................................................................................................................................................38

4. Editing.............................................................................................................................................................................................41

4.1 Select................................................................................................................................................................................... 41

4.1.1 Selection Tool.......................................................................................................................................................41

4.1.2 Select All................................................................................................................................................................41

4.1.3 Deselect All...........................................................................................................................................................41

4.1.4 Invert Selection....................................................................................................................................................42

4.1.5 Previous Selection............................................................................................................................................. 42

4.1.6 Select Lower / Higher.......................................................................................................................................42

4.1.7 Selector Window................................................................................................................................................ 42

4.2 Copy & Paste................................................................................................................................................................... 46

4.2.1 Cut............................................................................................................................................................................46

4.2.2 Copy........................................................................................................................................................................ 46

4.2.3 Paste........................................................................................................................................................................46

4.2.4 Delete...................................................................................................................................................................... 46

4.3 Undo & Redo....................................................................................................................................................................47

4.3.1 Undo........................................................................................................................................................................ 47

4.3.2 Redo........................................................................................................................................................................ 47

4.3.3 History.....................................................................................................................................................................47

4.4 Tools..................................................................................................................................................................................... 47

4.4.1 Select Tool.............................................................................................................................................................47

4.4.2 Edit Spline Tool................................................................................................................................................... 47

4.4.3 Cut Tool..................................................................................................................................................................48

4.4.4 Transform Tool..................................................................................................................................................... 48

4.4.5 Edit Paint Tool..................................................................................................................................................... 50

4.4.6 Pan tool..................................................................................................................................................................50

4.4.7 Zoom Tool............................................................................................................................................................. 50

4.4.8 Page Box Tool..................................................................................................................................................... 50

4.4.9 Ruler Tool...............................................................................................................................................................50

4.4.10 Guide Tool...........................................................................................................................................................52

4.4.11 Rectangle Tool.................................................................................................................................................. 57

4.4.12 Ellipse Tool..........................................................................................................................................................57

4.4.13 Star Tool.............................................................................................................................................................. 57



i-Cut Preflight

iv

4.4.14 Polygon Tool...................................................................................................................................................... 57

4.4.15 Pen Tool...............................................................................................................................................................57

4.4.16 Type Tool............................................................................................................................................................. 58

4.4.17 Text Block Tool................................................................................................................................................. 58

4.4.18 Densitometer Tool............................................................................................................................................58

4.4.19 Measure Tool..................................................................................................................................................... 58

5. Appearance.................................................................................................................................................................................. 59

5.1 Fill Paint / Stroke Paint.................................................................................................................................................59

5.1.1 No Paint................................................................................................................................................................. 60

5.1.2 Flat............................................................................................................................................................................60

5.1.3 Shading...................................................................................................................................................................60

5.1.4 Image.......................................................................................................................................................................61

5.1.5 Pattern.................................................................................................................................................................... 62

5.1.6 Overprint.................................................................................................................................................................63

5.1.7 Registration...........................................................................................................................................................64

5.2 Paint Transformation......................................................................................................................................................64

5.2.1 Paint Tool...............................................................................................................................................................64

5.2.2 Fill Paint Transformation window.................................................................................................................66

5.3 Stroke Window.................................................................................................................................................................68

5.3.1 Width....................................................................................................................................................................... 69

5.4 Transparency.....................................................................................................................................................................69

5.4.1 Object / Group Transparency........................................................................................................................ 70

5.4.2 Blend Modes........................................................................................................................................................70

5.4.3 Opacity....................................................................................................................................................................73

5.4.4 Mask........................................................................................................................................................................ 73

5.4.5 Clip........................................................................................................................................................................... 75

5.4.6 Invert........................................................................................................................................................................75

5.4.7 Isolate Blending.................................................................................................................................................. 75

5.4.8 Knockout Group..................................................................................................................................................76

5.4.9 Opacity & Mask define Knockout Shape................................................................................................. 76

5.5 Appearance Window......................................................................................................................................................77

5.5.1 Defining an Appearance.................................................................................................................................. 77

6. Objects........................................................................................................................................................................................... 80

6.1 Shapes.................................................................................................................................................................................80

6.1.1 Rectangle...............................................................................................................................................................80

6.1.2 Ellipse...................................................................................................................................................................... 82

6.1.3 Star...........................................................................................................................................................................82

6.1.4 Polygon...................................................................................................................................................................83

6.2 Paths.................................................................................................................................................................................... 84

6.2.1 Drawing a Path................................................................................................................................................... 84

6.2.2 Editing a Path...................................................................................................................................................... 86

6.2.3 Joining Paths....................................................................................................................................................... 87



Contents

v

6.2.4 Converting to a Path........................................................................................................................................ 87

6.2.5 Object Window: Path........................................................................................................................................87

6.3 Object Transformation...................................................................................................................................................88

6.3.1 Object Transformation Window.................................................................................................................... 88

6.3.2 Mirror objects.......................................................................................................................................................90

6.3.3 Scissors Tool........................................................................................................................................................90

6.4 Operations on Several Objects................................................................................................................................. 92

6.4.1 Align......................................................................................................................................................................... 92

6.4.2 Compound Path..................................................................................................................................................92

6.4.3 Group.......................................................................................................................................................................93

6.4.4 Clipping Mask......................................................................................................................................................94

6.4.5 Unite.........................................................................................................................................................................94

6.4.6 Intersect..................................................................................................................................................................95

6.4.7 Exclude................................................................................................................................................................... 95

6.4.8 Back minus Front...............................................................................................................................................95

6.4.9 Front minus Back...............................................................................................................................................96

7. Text...................................................................................................................................................................................................97

7.1 Text Detection...................................................................................................................................................................97

7.2 Edit Text..............................................................................................................................................................................97

7.2.1 Select Text.............................................................................................................................................................97

7.2.2 Edit Text................................................................................................................................................................. 97

7.2.3 Search and Replace Text................................................................................................................................98

7.3 Text Properties...............................................................................................................................................................102

7.3.1 Font........................................................................................................................................................................103

7.3.2 Paragraph............................................................................................................................................................103

7.3.3 Hyphenation (Mac OS X only).................................................................................................................... 104

7.3.4 Language (Spell Checker)(Mac OS Only)...............................................................................................104

7.3.5 Orientation...........................................................................................................................................................104

7.4 Text Boxes.......................................................................................................................................................................105

7.4.1 Create Text Box................................................................................................................................................105

7.4.2 Transform Text Box.........................................................................................................................................105

7.4.3 Split and Assemble Text Blocks................................................................................................................106

7.5 Text Linking.....................................................................................................................................................................107

7.6 Text Overview.................................................................................................................................................................108

7.7 Font Issues......................................................................................................................................................................109

7.7.1 Viewing Issues...................................................................................................................................................109

7.7.2 Editing Issues.................................................................................................................................................... 109

8. Layers........................................................................................................................................................................................... 111

8.1 Layers Window..............................................................................................................................................................111

8.1.1 View Layers........................................................................................................................................................ 111

8.1.2 Edit Layer Name.............................................................................................................................................. 113

8.1.3 New Layer...........................................................................................................................................................113



i-Cut Preflight

vi

8.1.4 Delete Layer.......................................................................................................................................................113

8.1.5 Send to Current Layer...................................................................................................................................113

8.1.6 Make Clipping................................................................................................................................................... 113

8.2 Arrange Objects in Layers........................................................................................................................................ 114

8.2.1 Bring to Front....................................................................................................................................................114

8.2.2 Bring Forward....................................................................................................................................................114

8.2.3 Send Backward................................................................................................................................................ 114

8.2.4 Send to Back.................................................................................................................................................... 114

8.2.5 Lock.......................................................................................................................................................................114

8.2.6 Unlock All............................................................................................................................................................114

8.2.7 Hide....................................................................................................................................................................... 115

8.2.8 Show All...............................................................................................................................................................115

9. Document................................................................................................................................................................................... 116

9.1 Document Information................................................................................................................................................ 116

9.1.1 Info......................................................................................................................................................................... 117

9.1.2 File..........................................................................................................................................................................117

9.1.3 History.................................................................................................................................................................. 117

9.1.4 Security................................................................................................................................................................ 117

9.2 Esko Normalized PDF.................................................................................................................................................118

9.3 Pages.................................................................................................................................................................................118

9.3.1 Insert Page......................................................................................................................................................... 118

9.3.2 Extract Page...................................................................................................................................................... 119

9.3.3 Delete Page........................................................................................................................................................120

9.4 Page Boxes.....................................................................................................................................................................120

9.4.1 Page Box Tool...................................................................................................................................................120

9.4.2 Page Box Transformation window............................................................................................................121

9.4.3 Crop Page to Page Box............................................................................................................................... 123

9.4.4 Apply Page Boxes to All Pages.................................................................................................................123

9.5 Separations..................................................................................................................................................................... 124

9.5.1 Document Separations.................................................................................................................................. 124

9.5.2 Modify Separation........................................................................................................................................... 125

9.5.3 Add Separation.................................................................................................................................................125

9.5.4 Delete Separation............................................................................................................................................ 125

9.5.5 Remap Separation...........................................................................................................................................126

9.5.6 Separations across the Document........................................................................................................... 126

9.6 Images...............................................................................................................................................................................127

9.6.1 Document Images........................................................................................................................................... 127

9.6.2 Attach / Detach ICC Profile......................................................................................................................... 128

9.6.3 Convert Image Color Space........................................................................................................................129

9.6.4 Place Image....................................................................................................................................................... 130

9.6.5 Delete Image......................................................................................................................................................131

9.6.6 Replace Image.................................................................................................................................................. 131

9.6.7 Edit Image...........................................................................................................................................................131



Contents

vii

9.6.8 Export Image..................................................................................................................................................... 132

9.6.9 Images across the Document.....................................................................................................................132

9.7 Fonts.................................................................................................................................................................................. 133

9.7.1 Document Fonts...............................................................................................................................................133

9.7.2 Change Font Embedding..............................................................................................................................134

9.7.3 Delete Font.........................................................................................................................................................136

9.7.4 Replace Font..................................................................................................................................................... 136

9.7.5 Fonts across the Document........................................................................................................................136

9.8 Flattener............................................................................................................................................................................136

9.8.1 PDF Version....................................................................................................................................................... 137

9.8.2 Flatten non-separable blend modes........................................................................................................ 137

9.8.3 Split DeviceN color spaces......................................................................................................................... 137

9.8.4 Resolve overprints...........................................................................................................................................138

9.8.5 Convert PS blends..........................................................................................................................................138

9.8.6 Flattening Resolution......................................................................................................................................139

9.8.7 Completely resample images......................................................................................................................139

9.9 Action Lists..................................................................................................................................................................... 139

9.9.1 Running an Action List..................................................................................................................................139

9.9.2 Managing Action Lists................................................................................................................................... 140

9.10 Preflighting.................................................................................................................................................................... 150

9.10.1 Preflighting a Document with a Preflight Profile............................................................................... 150

9.10.2 Managing Preflight Profiles........................................................................................................................152

10. Certified PDF.......................................................................................................................................................................... 159

10.1 History.............................................................................................................................................................................159

10.1.1 Session Information......................................................................................................................................159

10.1.2 Highlight  / Zoom.............................................................................................................................................160

10.1.3 Session Rollback........................................................................................................................................... 160

10.1.4 Show / Hide Details...................................................................................................................................... 161

10.2 Incremental Save........................................................................................................................................................161

10.3 Preflighting.................................................................................................................................................................... 161

10.3.1 Preflight Profiles.............................................................................................................................................161

10.3.2 Preflighting without Saving (Test Preflight)..........................................................................................162

10.3.3 Save and Preflight.........................................................................................................................................162

10.3.4 Certified Status...............................................................................................................................................163

11. Preparation for i-cut............................................................................................................................................................166

11.1 Adding or changing a Cut Path...........................................................................................................................166

11.1.1 Creating a Cut Path..................................................................................................................................... 166

11.1.2 Trace Cut Path............................................................................................................................................... 167

11.1.3 Offsetting a cut path....................................................................................................................................169

11.1.4 Smoothing a Cut Path................................................................................................................................ 170

11.1.5 Adding Nicks to a Cut Path......................................................................................................................170

11.2 Add Bleed..................................................................................................................................................................... 171



i-Cut Preflight

viii

11.3 Create White Underprint......................................................................................................................................... 172

12. Advanced..................................................................................................................................................................................173

12.1 Preferences...................................................................................................................................................................173

12.1.1 Viewing...............................................................................................................................................................173

12.1.2 Editing................................................................................................................................................................ 174

12.1.3 Certified PDF...................................................................................................................................................176

12.1.4 User Info........................................................................................................................................................... 177

12.1.5 Advanced..........................................................................................................................................................178

12.2 Shuttle.............................................................................................................................................................................178

12.2.1 Connecting i-cut Preflight's Shuttle to Workflow Servers............................................................. 178

12.2.2 Filter on Workflow Type.............................................................................................................................. 180

12.2.3 Submitting Files to a Workflow................................................................................................................181

12.2.4 Shuttle Window..............................................................................................................................................183



1
i-Cut Preflight | 1. Introduction | 9

1. Introduction

i-cut Preflight is a complete native PDF 1.4, 1.5, 1.6 and 1.7 viewer and editor. It is aimed at fast and
interactive PDF editing and correction in production environments.

Extremely user friendly and intuitive, i-cut Preflight offers great tools for extensive PDF native editing,
fine-tuned for the prepress production department and with full support for Certified PDF.

i-cut Preflight is not meant to replace Adobe Acrobat but rather provides sophisticated tools for
the prepress production professional who needs to be able to work on PDF files in a very fast and
interactive manner.

With i-cut Preflight you can avoid delays in the prepress cycle, time consuming turnaround times in
sending files back to customers and reprocessing them all over again, and costly press downtime.

Some of the functions that are available in i-cut Preflight include highly interactive transformation of
objects, changing colors and transparencies, modifying, mapping and adding separations, text and
paragraph editing, replacing and importing pictures, changing page boxes, etc.

This User Guide gives a full description of all options, functions, settings, etc., in i-cut Preflight.

1.1 Licensing

When launching i-cut Preflight for the first time, you will automatically get the licensing dialog.

You can choose between

• running a 30 day trial license
• Activate your software using a product key
• Connect to a License Server

For more information on activating your software locally (using a Trial license or a Product Key),
see the Local License Manager documentation: http://help.esko.com/products/Local%20License
%20Manager

For more information on using a Network license, see the Network License Manager documentation:
http://help.esko.com/products/Network%20License%20Manager

1.2 About i-cut Preflight

The About i-cut Preflight window (accessible from the i-cut Preflight menu) contains information
about your copy of i-cut Preflight.

1.3 The Reference Manual

This Reference Manual is split up into the following chapters:

http://http://help.esko.com/products/Local%20License%20Manager
http://http://help.esko.com/products/Local%20License%20Manager
http://help.esko.com/products/Network%20License%20Manager
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Introduction

The Introduction contains License Terms and Copyright information, a small note on installation, and
an overview of the contents of the different chapters in this manual.

See Introduction.

Files

The Files chapter contains information on how to handle files: new, open, save... and the setups for
printing.

See Files.

Viewing

The Viewing chapter explains the i-cut Preflight workspace, how to set the view (preview modes,
view options, show separations...), how to navigate through a job (zoom, pan, page browsing...) and
the checking tools (measure and densitometer tools).

See Viewing.

Editing

The Editing chapter contains all editing functionality. The selecting possibilities, copy / paste and
undo  /  redo are explained. This chapter also gives an overview of all the tools available in i-cut
Preflight.

See Editing.

Appearance

The Appearance chapter deals with the appearance, fill paint, stroke and transparency settings for
all objects.

See Appearance.

Objects

The Objects chapter contains information on how to create and modify objects: drawing and editing
predefined or freehand shapes, and operations on multiple objects (groups, compounds, clipping
masks, ...).

See Objects.

Text

The Text chapter contains information on how to create and modify text, and some font issues.

See Text.

Layters

The Layers chapter explains how to view and use layers (e.g.: making a clipping with a layer),
and how to arrange objects in layers (moving them forward or backward, locking / unlocking and
showing / hiding them).

See Layers.

Document

The Document chapter deals with the general editing of a document, for example
inserting / extracting pages, resizing page boxes, and also editing separations, images and fonts,
by page or for the whole document.
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See Document.

Certified PDF

The Certified PDF chapter describes all windows and settings for using the Certified PDF technology
(History, Save and Preflight, Profiles...).

See Certified PDF.

Preparation for i-cut

i-cut Preflight contains a number of functions and tools specific for the collaboration with i-cut Layout
or i-cut Automate. These are described in this chapter. See Preparation for i-cut on page 166

Advanced

The Advanced chapter describes the Preferences for i-cut Preflight.

See Advanced.
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2. Files

2.1 New

This creates a new document. You can choose the number of pages and the page size.

Shortcut: Command + N (Mac) or Ctrl + N (Windows)

2.1.1 Page Size

You can either enter a page size manually, or use a predefined page size.

• To enter a page size manually, choose “Custom” and define a Page Width and Page Height.
• To use a predefined page size, choose it in the Page Size list.

2.1.2 Colors

All new files contain the four process colors by default, but you can change the separations available
in the Separations window (see Separations).

2.2 Open

You can open an existing PDF (PDF 1.3, 1.4, 1.5 and 1.6). You can only open PDF files and Illustrator
".ai" files if they are saved with PDF compatibility set to "on" in Illustrator.
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You can open a file by dropping it on the i-cut Preflight icon in your Dock, by using the Open function
in the File menu, or by using the Command + O (Mac) or Ctrl + O (Windows) shortcut.

Note:  You cannot open files larger than 10 x 10
meters.

You can only open PDF files (including inPDF files) and Illustrator “.ai” files if they are saved with PDF
compatibility set to “on” in Illustrator. Trying to open another file type will generate a warning.

Shortcut: Command + O (Mac) or Ctrl + O (Windows)

2.3 Open Recent

The ten most recently opened PDF files can be opened quickly using the Open Recent list in the
File menu.

2.4 Close

You can close a document using the red button in the upper left corner, by the Close function in the
File menu, or by its shortcut.

Shortcut: Command + W (Mac) or Ctrl + W (Windows)

When closing the last window of a document that contains unsaved changes, you will have the
following options:

• Don't save: Closes the document without saving (you can also use Command + D).
• Cancel: Doesn't close the window (you can also press Escape).
• Save: Saves the document and closes it (you can also press Enter). You can have several options

when saving a document (see Save).

2.5 Save

You can save a document using the Save function in the File menu, or using the Save shortcut.

Shortcut: Command + S (Mac) or Ctrl + S (Windows)

This saves all changes to the PDF file. It is only enabled when there are unsaved changes in the
current document or for new documents.

2.5.1 Saving a New Document

When saving a new document, the behavior will be the same as Save As (see Save As).
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By default, i-cut Preflight saves all new documents to the PDF 1.4 version. If you want your document
to have another PDF version (1.3, 1.5 or 1.6), you can flatten it to that PDF version. See Flattener.

2.5.2 Saving an Existing Document

When saving an existing document, i-cut Preflight preserves the PDF version it already has.

Note:  If you add blend modes to a PDF 1.3
document, i-cut Preflight will save it as a PDF 1.4.
If you want to keep it as a PDF 1.3, you need to
flatten it to that PDF version. See Flattener.

2.5.3 Saving a Certified PDF Document

Your document is Certified if you have selected the "Certified PDF" option on the first save, or when
using Save As (see Save As).

When saving a Certified PDF, you must enter a session comment. This comment will be remembered
for all consecutive saves of the same session.

See Session Information for details.

2.5.4 Backup

You can choose to make an automatic backup of your original file every time you save it. See Make
Backup on Save.

2.6 Save As

Saves the current document under a new name. You will be presented with several options after
choosing a location to save:
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• Certified PDF: Allows you to include (or remove) Certified PDF information. This option will be
enabled by default if the document was already Certified or when “Always enable Certified PDF”
is set in the Preferences (see Always enable Certified PDF).

• Incremental save: All changes will be saved incrementally to enable roll back to the previous
sessions (see Incremental Save). This is only available if “Certified PDF” is enabled.

• Session comment: Comment for the current session (see Session Information). This is only
available if “Certified PDF” is enabled.

Save As can be applied using the Save As function in the File menu, or by its shortcut.

Shortcut: Shift + Command + S (Mac) or Ctrl + Shift + O (Windows)

2.7 Save and Preflight

This function allows you to save and preflight the current document with a profile of your choice. For
more information see Save and Preflight.

Shortcut: Command + option + S (Mac) or Alt + Ctrl + S (Windows)

2.8 Revert to Saved

This function reverts the current document to the state it was in when last saved with “Save”, “Save
As...” or “Save and Preflight...”.

This is particularly useful to avoid having to undo several actions.

Note:  “Revert to Saved” cannot be undone by
Command + Z  or Ctrl + Z.

2.9 Page Setup

This option in the File menu opens the standard Mac OS Page setup window.

Shortcut: Shift + Command + P
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2.10 Print

2.10.1 Printing to Pdf

Outputting the file as PDF retains all of its features (layers, transparencies, separation control...). This
can be done in 3 different ways in the Print window:

• Using the PDF button and clicking “Save as PDF”.
• Using the PDF button and selecting one of the predefined PDF-related actions (e.g.: “Compress

PDF”).

Note:  These predefined actions are only
available in Mac OSX Tiger or later.

• Choosing a PDF-enabled printer. This is generally a workflow (e.g.: created with Odystar or
Nexus).
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Note:  Only the page range of the Print window
is taken into account when printing to PDF,
everything else is ignored.

2.10.2 Printing to a Device (Printer Driver)

When printing to a device that doesn't support PDF (e.g. a PostScript printer driver), i-cut Preflight
uses the Mac OSX Print engine to print.

Note:  On operating systems older than Mac
OSX Tiger, the Mac OSX Print engine flattens
overprints. This can result in lineart or text being
converted into images and cause a loss in
sharpness. In this case, you should use the i-cut
Preflight flattener (see Flattener) to flatten your file
before printing and ensure a good print result.
On Mac OSX Tiger and Leopard, overprints are
printed correctly.
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3. Viewing

3.1 The i-cut Preflight Workspace

When you first launch i-cut Preflight, its default workspace consists of:

On the left:

• the document window - containing the open document(s) and the tool bar.

On the right:

• the Separations window,
• the Errors & Warnings window,
• the Layers window,
• the Selector window,
• the Fill Paint window,
• the Stroke window,
• the Object Transparency window,
• the Object Transformation window,
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• the Object window.

3.1.1 Tool Bar

The tool bar, at the top of the document window, contains buttons and tools to view and edit your
document.

When you open i-cut Preflight for the first time, your tool bar contains the following:

• View buttons,
• Navigate tools,
• Select tool,
• Path tool,
• Transform tool,
• Shape tool,
• Text tool,
• Guides tool,
• Nicks tool,
• Trace Cut Path tool
• Layers button,
• Separations button,
• Images button,
• Inspector button.

You can customize your tool bar, so you always have easy access to the tools and buttons you use
the most.

Customizing the Tool Bar

1. Right-click your tool bar and select Customize Toolbar...

This opens a pop-up containing all the tools and buttons you can add to the tool bar.
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2. Drag your desired tools / buttons onto the tool bar.

Tip:

• You can organize your tool bar by adding
separators, spaces or flexible spaces.

• To go back to the default tool bar, drag the
default tool bar set onto the tool bar.

3. Choose if you want to show only the icon, only the text, or both for your tools and buttons.

By default, the tool bar shows both the icon and the text.

4. If you want to add lots of tools and buttons or the tool bar, or maximize the viewing space for
your document, select "Use Small Size" to make the tools and buttons smaller.

5. Click "Done" when you are finished.

All document windows will now have the new tool bar.

3.1.2 Navigation Bar

The bottom left corner of the document window indicate the current document page you are viewing,
and the zoom factor you are viewing it at.
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You can use this area to change the zoom factor (see Zoom Factor), or navigate between the
document's pages (see Page Browsing).

3.1.3 Palette Magnetism

You can attach the top of a palette to the bottom of another palette. When moving a palette, all
palettes attached to it (downwards) will be moved along. To detach palettes from one another, move
the bottom palette.

3.1.4 Show / Hide Palettes

To show or hide all of the i-cut Preflight palettes, go to Window / Show palettes (when they are
hidden) or Window / Hide palettes (when they are visible).

Shortcut: F8 (Mac)

3.2 Views

3.2.1 New View

New View in the View menu opens a new window for the current document. Both windows have
their own view options.

3.2.2 Switch Views

If multiple files are open, the bottom part of the Window menu lists all open document windows, so
you can bring another document to the front.

Shortcut: Command + ~ (Mac)

3.2.3 Tile Views
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Vertical

Divides the available space vertically among all open windows.

Horizontal

Divides the available space horizontally among all open windows.

Panes

All the open windows are laid out like a mosaic on the available space.

Stack

All the open windows are stacked on top of each other.

3.2.4 Synchronize Views

This option, available from the View menu, enables you to synchronize several views of the same file
(generated by the New View option, see New View).

This means that the zooming and panning that you apply to one of the windows will automatically
be applied to the other windows as well.

3.2.5 View Options Window

Go to Window/View Options to open the View Options window.
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On Windows, i-cut Preflight shows the extended version of the View Options window. On Mac OS
X, you can click the green “+” button ( ) or use the shortcut to hide/show the bottom and middle
parts of the window

Shortcut: Shift + Command + Y (Mac) or Ctrl + Shift + Y (Windows)

i-cut Preflight will remember this viewing preference next time you start it.

Preview

There are several preview modes available in i-cut Preflight: Outline, Preview and Page mode.

• Outline shows only the outlines of all paths, on a white background filling the screen. This is the
default preview mode when you install i-cut Preflight.

• Preview shows the regular version of the file (filled with separations), on a white background filling
the screen.

• Page shows the filled version of the file, cut to the size of the page (Trim Box). This preview mode
doesn't show cut, bleed and registration marks.
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To choose one of these View Modes, you can either:

•
Click one of the View buttons  in the tool bar.

• Go to View/Switch View Mode.

Note:  This switches between Outline and either
Preview or Page (depending on which one was
most recently used).

• Use the shortcut.

Shortcut: Command + Y (Mac) or Ctrl + Y (Windows)

Color

The Color buttons  are available when your file is in Preview or Page mode.

• Colors: this shows all separations in their appropriate colors.
• Black: this shows all separations in grayscale. Use this with the View Separations window to check

the file separation by separation, as they would appear on film (see View Separations Window).
• Negative: this shows all separations in grayscale and inverted.

Orientation

The Orientation buttons  allow you to rotate your document's preview. This makes
it easier to correct e.g. imposition pages.

Note:  This only rotates the preview. When saving
your document, it will have the same orientation
as it did initially.
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Selections

When the Selections option is enabled, i-cut Preflight shows selected paths in the Selection color
defined in the Preferences (see Viewing).

When it is disabled, it doesn't show selected paths.

By default, this option is enabled.

Outlines

In Outline mode, the Outlines option is always on.

Enable it in Preview and Page mode to make the outlines visible.

Strokes

Enable the Strokes option to make the outline of strokes visible in Outline mode and when selecting.

Clips

The Clips option will make clipping paths visible in Outline mode.

In Preview and Page mode, it will make them visible when you select them and when the Outline
option is on.

Comments

Enable the Comments option to display notes added in e.g. Acrobat. You can move, close or minimize
notes.

Opaque Inks

This option is enabled by default. Disable it and enable Overprints if you want to show opaque inks
as transparent (e.g. to check trapping towards opaque inks).

Outline Text

Enable this option if you want to see text as outlines instead of filled.

Check Spelling (Mac OS X Only)

This option is only available when running on Mac OS X. Enable this option to underline misspelled
words in red. The language of the spelling checker is determined automatically. You can see it and
change it in the Object window when text is selected (see Language (Spell Checker)(Mac OS Only)).

Overprints

Enable this option to highlight all objects in overprint.
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Transparencies

Enable this option to highlight all transparencies (overprints and blend modes).

Breakouts Below

Enable this option to highlight all areas having a percentage lower than the value you enter, in any
separation.

This allows you to edit (e.g. add ink or remove) areas that may not appear on print.

Ink Coverage Above

Enable this option to highlight all areas with a higher ink coverage than the value you enter.

Traps

Enable this option to highlight all traps.

3.2.6 View Separations Window

The View Separations window (in the Windows menu) allows you to hide or show some or all
separations on the screen. To add, delete or modify separations, see Separations.

Special inks (Varnish, Technical or Opaque) are indicated by a “V”, “T” or “O”.

Clicking the eye in front of a separation shows or hides it.
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All

Click the “All” button to display all separations. If the “All” button was already selected, all separations
will be hidden.

Single

The “Single” button will hide all separations except for one.

If the “Single” button is on, showing another separation will always hide the one that was selected
previously.

Deselect the “Single” button to view multiple separations again.

3.2.7 View Page Boxes Window

The Page Boxes window (in the Windows menu) allows you to show or hide page boxes, by clicking
on the eye icons in front of them.

All

Click the "All" button to display all page boxes. If the "All" button was already selected, all page
boxes will be hidden

You can show or hide all page boxes with the Shortcut: Command + B (Mac) or Ctrl + B (Windows)

Single

The “Single” button will hide all page boxes except for one.

If the “Single” button is on, showing another page box will always hide the one that was selected
previously.

Deselect the “Single” button to view multiple page boxes again.

Note:  You can define the colors used for the
individual page boxes in the Preferences: See
Viewing.

For more information on Page Boxes and how to define them: see Page Box Tool.
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All

Click the “All” button to display all page boxes. If the “All” button was already selected, all page
boxes will be hidden.

Single

The “Single” button will hide all page boxes except for one.

If the “Single” button is on, showing another page box will always hide the one that was selected
previously.

Deselect the “Single” button to view multiple page boxes again.

Shortcut: Command + B (to show / hide all page boxes)

Note:  You can define the colors used for the
individual page boxes in the Preferences: See
Viewing.

For more information on Page Boxes and how to define them: see Page Box Tool.

3.3 Navigating in a File

3.3.1 Zooming

There are several ways to change the zoom factor:

Zoom Tool

•

To zoom in: click your document with the Zoom Tool  to zoom in by 140% each time, or
drag a rectangle to zoom in on a certain part of the document.

Note:  With the powerful Zoom Tool in i-cut
Preflight, you can zoom in until you see single
pixels.

• To zoom out: hold the Option key when clicking to reduce the zoom factor to 70%.

Shortcut: Command + Space (Mac) or Ctrl + Space (Windows)

Note:  On Mac OS X Tiger, Command + space
opens Spotlight, so you should use Space +
Command (in that order) to zoom.
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Zoom Factor

You can see the current zoom factor in the bottom left part of the document window.

You can choose a predefined zoom factor in the drop-down list.

Zoom to Fit

Zoom to Fit (in the View menu) will fit the document in the window.

In page mode, this will fit the Trim Box to the window, while in outline or preview mode, the bounding
box of the content is used.

Shortcut: Command + 0 (zero) (Mac) or Ctrl + 0 (zero) (Windows)

Zoom In

The Zoom In function in the View menu zooms in on the center of the window by a factor of 140%.

Shortcut: Command + + (Mac) or Ctrl + + (Windows)

Zoom Out

The Zoom Out function in the View menu zooms out on the center of the window by a factor of 70%.

Shortcut: Command + - (Mac) or Ctrl + - (Windows)
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Zoom to Selection

The Zoom to Selection function in the View menu zooms in on the current selection.

Shortcut: Command + shift + 0 (Mac) or Ctrl + Shift + 0 (Windows)

3.3.2 Panning

The Hand Tool  allows you to pan the current view.

You can also use the scroll bars in the document window to pan the current view.

Shortcut: Space

Note:  If there is another tool selected, you can still
pan by holding SPACE and dragging your mouse.

3.3.3 Navigation Window

The Navigation window is used to define the preview of the file. A small preview is shown on the left,
with a red rectangle marking the previewed area.

To modify this area, drag the rectangle, create a new one with the cursor, or use the settings on
the right.

Use the sliding bar or the "+" and "-" buttons to zoom in or out of the document. The value at the
top shows the zoom factor, which can be entered manually.

The page button  fits the file preview to the window (like the View/Zoom to Fit function).

The arrow button  fits the preview size to the selection (like the View/Zoom to Selection function).
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The “1:1” button displays the file preview with a 100% zoom.

3.3.4 Page Browsing

If your PDF file has several pages, you can navigate through them by:

• Using the “Go to” function in the View menu,

• Typing the page number or page label you want to go to in the page browser at the bottom of
the window:

click in  then type the number .
• Using the arrows of the page browser  at the bottom of the window:

•  to go to the first page,
•  to go to the previous page,
•  to go to the next page,
•  to go to the last page.

• Using one of the shortcuts:

• Command + Page Up (Mac) or Ctrl + Page Up (Windows) or Home / Top key  to go to the
first page,

• Page Up to go to the previous page,
• Page Down to go to the next page,
• Command + Page Down (Mac) or Ctrl + Page Down (Windows) or End key  to go to the

last page.

3.4 Checking

3.4.1 Densitometer Tool

The Densitometer Tool  will show the separation values and the total ink percentage at the
mouse location when clicking or dragging.

The densities shown are the average of a 3 by 3 pixels square. Hold Shift while clicking or dragging
to get the densities at a single pixel.
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Hold Option (Mac) or Alt (Windows) while clicking to get the separation names.

You can also double-click the Densitometer Tool to open the View separations window and see the
separation names.

3.4.2 Measure Tool

When clicking or dragging the Measure Tool , it will show the distance of that point to the left
and bottom of the trim box (or to the ruler origin if the ruler is shown).

To measure the distance from one point to another, click again to select the end point. The window
will now show the total, horizontal and vertical distance as well as the angle between the two points.

3.4.3 Object / Selection Size

You can see the size of the bounding box of a selection in the Object Transformation window. It
displays the Vertical size, the Horizontal size and the location (based on the Trim Box or the center
of the ruler).

See Object Transformation.

3.4.4 Errors & Warnings

Every time i-cut Preflight encounters an error / warning... (e.g.viewing a page with an error), it will
open the Errors & Warnings window automatically.
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This windows shows all

•
errors 

•
errors that can be signed-off  (see Sign-Off)

•
signed-off errors 

•
warnings, 

•
fixes 

•
information 

that the page / document contains.

These can be:

• Document errors or warnings (“Open Document”): faulty pages, glyphs of a font missing....
• Preflight errors, warnings and fixes (“Preflight Report”): errors and warnings found or fixes

performed when preflighting the document in i-cut Preflight using “Save and Preflight”.
• Errors, warnings, fixes or information related to user actions: generated when doing a specific

action (for example, preflighting with a preflight profile, running an action list, pasting an object,
remapping separations...).

Note:  This window is also available in the Window
menu (Window/Errors& Warnings).

Show Pages / Hide Pages

Click the  button to show (or hide) the pages column.

In this column, click a particular page to see entries for this page, or click “All Pages” to the see
entries for the whole document.



3
34 | i-Cut Preflight | 3. Viewing

Show

Use the “Show” filter to show:

• all errors, warnings fixes and information (“Everything”),
• errors and warnings encountered when opening a page (“Document”),
• errors, warnings and fixes from the embedded preflight report (“Preflight Report”),
• errors, warnings, fixes and information generated by an action (e.g.: “Make 2 Color Job”).

View in Document

If the error / warning is related to an object, you can click this error / warning to select the object,
or double-click it to zoom in on that object.

Reported by

When you click an error, warning or fix, you can see what generated it at the bottom of the window.
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Note:

For Preflight errors, warnings and fixes, you can
see the name of the preflight profile used for the
preflight in:

• the Errors & Warnings window, the Preflight
Report and the Certified Status of your
document (if you used “Save and Preflight”), if
your file was preflighted in i-cut Preflight,

• the Preflight Report and the Certified Status of
your document, if your file was preflighted in
another application (e.g. PitStop Pro).

For more information on the Certified Status, see
Certified Status.

Show Report Document

The “Show Report Document” button  at the bottom right of the Errors & Warnings window
opens the embedded Preflight Report as a separate PDF file. It shows the errors and warnings,
general file information, font information and image information.

You can print and save it as any normal PDF file.

Severity

When you click an error, warning or fix, you can see its severity at the bottom of the window.
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Sign-Off

When i-cut Preflight encounters an error that you can sign-off (mark as approved), it displays the

sign-off icon  beside it.

The types of errors that you can sign-off are defined in the preflight profile you preflight your document
with. See Problem Categories.

To sign-off the error, click the sign-off button  in the Severity area.

This opens a window for you to enter the sign-off reason.

Once an error has been signed-off, its icon changes to  in the Errors and Warnings window.

Note:  After signing-off an error, you must Save
and Preflight your document with the profile that
generated the error you signed-off. See Save and
Preflight.

The sign-off reason is displayed in the “Severity” area, the Preflight Report and the History window.
For more information on the History window, see History.

Partial Sign-Off

You can choose to only sign-off one of the objects affected by the error. To do this, click the triangle

beside the error, select the object and click the sign-off button  in the Severity area.
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Unsign-Off

You can unsign-off an error, for example if you think the sign-off reason isn't valid. To do this, select

the error and click the unsign-off button  in the Severity area.

Partial Unsign-Off

To only unsign-off one of the objects affected by a signed-off error, click the triangle beside the error,

select the object and click the unsign-off button  in the Severity area.

3.4.5 PitStop Report Information

You can use i-cut Preflight to view the information (errors, warnings...) contained in a PitStop Report
directly in the file. Use this for files preflighted with PitStop Pro.

To do this:

Open your PDF file in i-cut Preflight.

Use File/Insert... to open the report file. This opens the Errors and Warnings window.



3
38 | i-Cut Preflight | 3. Viewing

Note:  You can also drag and drop the report file
onto the i-cut Preflight icon in the Dock, or open it
from i-cut Preflight's Shuttle (see Shuttle).

In the Errors and Warnings window, select “Insert Report Document” to view only the report's entries.

Click an error / warning / ... in the window to highlight the area in the file.

3.4.6 File Differences

You can also use i-cut Preflight to view the differences between two files. You can use this for example
when you compared the files in Odystar, they didn't match, and you want to see where the differences
are.

To view the areas that are different in the mismatched file

In the Odystar canvas, hold Command and double-click the mismatched job to open it in the Finder.

Drag and drop the mismatched file then the report file onto the i-cut Preflight icon in the Dock.

Note:  You can also open the report file from i-cut
Preflight using File / Insert, or open it from i-cut
Preflight's Shuttle (see Shuttle).

In the Errors and Warnings window, select “Insert Differences”to view only the differences entries.
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Note:  Differences are grouped by separation in
the Errors and Warnings window.

Click a difference entry in the window to highlight the difference in the file.

Note:  You can also use the Shuttle Standalone
application to open the mismatched file in your
workflow and see the differences in i-cut Preflight.
To do this, go to Shuttle's Preferences and set your
i-cut Preflight application to open the file types of
the mismatched file and of the compare report. For
more information, see the Shuttle manual.

To see the mismatched file and the original file side byside

Open the original file in i-cut Preflight too.

Go to View / Tile Horizontally (or View / Tile Vertically).
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4. Editing

4.1 Select

4.1.1 Selection Tool

At any time, you can temporarily switch to the Selection Tool  by holding the Command key
(Mac) or Ctrl (Windows).

• In “Outline” selection mode, click near the outline of an object to select it.
• In “Area” mode selection mode, click inside an object to select it (this selects the topmost filled

object at that location).

Note:  You can set the selection mode in the
Editing Preferences (see Editing), but you can
always temporarily switch to the other mode
by holding the Option key (Mac) or Alt key
(Windows).

• Drag to select all the objects that fall entirely inside the drag rectangle.
• Hold Shift to toggle the selection when clicking or dragging. Selected objects will be deselected

and vice versa.

4.1.2 Select All

Select All (in the Edit menu) selects all the objects in the document, except for the locked or hidden
objects. When the Type Tool is active, it selects all the text in the active text block.

Shortcut: Command + A (Mac) or Ctrl + A (Windows)

4.1.3 Deselect All

Deselect All (in the Edit menu) deselects all the objects in the document, except for the locked or
hidden objects.
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Shortcut: Shift + Command + A (Mac) or Ctrl + Shift + A (Windows)

4.1.4 Invert Selection

Invert Selection (in the Edit menu) will invert the selection of all the objects in the document, except
for the locked or hidden objects. What is selected will be deselected and vice versa.

Shortcut: Option + Command + A (Mac) or Ctrl + Alt + A (Windows)

4.1.5 Previous Selection

Previous Selection (in the Edit menu) reverts to the previous selection. This is most useful after
accidentally losing the selection due to an unwanted click.

Shortcut: Option + Command + Z (Mac) or Ctrl + Alt + Z (Windows)

4.1.6 Select Lower / Higher

When several objects are superimposed and you are in “Area” selection mode (see the Preferences
chapter: Editing), you can only select the topmost object directly. With Select Lower and Select
Higher, you can select each superimposed object successively.

Note:  This works within a layer or across different
layers.

Select Lower

To select the object below the one you selected, make sure you have clicked a point where the two
objects intersect with each other, and click Edit/Select Lower.

Shortcut: Option + Command + ARROW DOWN

Select Higher

After using Select Lower, you can go back up by using Edit/Select Higher.

Shortcut: Option + Command + ARROW UP

4.1.7 Selector Window

The Selector window allows you to select objects based on their characteristics.
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To define these characteristics, first select an option from the first drop down menu (“Fill Paint”,
“Stroke Paint”, “Stroke”, “Transparency”, “Path”, “Text” or “Traps”). Then refine your selection with
the second drop down menu (its contents change according to what you selected first).

Note:

For certain characteristics, you will have to further
refine your criteria, with additional drop down
menus, equality / inequality symbols (click “<” to
change it to “=” or “>”) and input fields.

Once the characteristics are defined, click one of the arrow buttons to determine the type of selection
you want:

•
To select all of the objects who have the defined characteristics, click the “Select” button .

• To add the objects with the defined characteristics to an existing selection, click the “Add to

selection” button .
• To remove the objects with the defined characteristics from an existing selection, click the

“Remove from selection” button .
• To search for objects with the defined characteristics within an existing selection, click the

“Intersect with selection” button .

Fill Paint

This allows you to select objects that have specific types of Fill Paint. The options are:

• Overprint: This selects all the objects that are overprinting.
• Registration: This selects all the objects defined in Registration color space.
• None: Selects all the objects with no Fill Paint.
• Flat: Selects all the objects with a flat Fill Paint (no shading)
• Shading: Selects all the objects with a shading as Fill Paint. You can refine your selection with

the following options:

• All: selects all objects with a shading
• Axial: selects all objects with an axial shading
• Radial: selects all objects with a radial shading
• Uneditable: selects all objects with a shading which cannot be edited in i-cut Preflight (neither

axial nor radial).
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• Image: Selects all the objects with an image as Fill Paint. You can refine your selection with the
following options:

• All: selects all objects with an image as Fill Paint.
• OPI: selects all objects with an external (not embedded) image as Fill Paint
• Color: selects all objects with an image belonging to a particular color space: RGB, Lab, Gray,

CMYK, BW (1-bit images) or Spot (DeviceN)
• Type: selects all objects with an image of a particular type: JPEG or Lossless
• Res: Selects all objects with an image that has a resolution lower, equal or higher than a

specified value
• Pattern: Selects all the objects with a pattern as Fill Paint. You can refine your selection with the

following options:

• All: selects all objects with a pattern as Fill Paint.
• Colored: selects all objects with a colored pattern as Fill Paint
• Uncolored: selects all objects with an uncolored pattern as Fill Paint

• Matches: Selects all the objects with a Fill Paint that matches the current Fill Paint in the Fill Paint
window (shown in the square besides "Matches").

Stroke Paint

This allows you to select objects that have specific types of Stroke Paint. The selection options are
exactly the same as the ones for Fill Paint, but applied to the Stroke Paint.

Stroke

This allows you to select objects that have specific types of stroke.

• All: Selects all objects with a stroke
• Width: selects all objects with a stroke width lower, equal or higher than a specified value
• Cap: selects all objects with a stroke cap of the selected type. Click on one of the buttons on the

side to select the cap type .
• Join: selects all objects with a stroke join of the selected type. Click on one of the buttons on the

side to select the join type. When miter is selected, you can select the objects with a miter limit

lower, equal or higher than a specified value .
• Dashed: Selects all objects with a dashed stroke.

Transparency

This allows you to select objects which have specific transparencies.

• All: Selects all objects with a transparency other than the default one (by default, objects have
Normal blend mode and 100% opacity).

• Objects: Selects only objects (and no groups) with a transparency other than the default one.
• Groups: Selects only groups (and no single objects) with a transparency other than the default

one.
• Blend Mode: Selects objects with a specific blend mode:
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• All: selects all objects with a blend mode other than Normal.
• Non separable: selects all objects with a non separable blend mode (Hue, Saturation, Color,

Luminosity).
• Normal / Multiply / Screen / Overlay / Soft Light / Hard Light / Color Dodge / Color Burn /

Darken / Lighten / Difference / Exclusion / Hue / Saturation / Color / Luminosity: selects all
objects with the selected blend mode.

For more information on blend modes, see Blend Modes.
• Opacity: Selects all objects with an opacity lower, equal or higher than a specified value.
• Opacity Mask: Selects all objects that have a softmask.
• Stencil Mask: Selects all objects that have a Stencil Mask.

Note:  You can use this to get rid of unwanted
stencil masks generated by bad PDF exports
(e.g. tables exported from Word). Select all
stencil masks with the Selector window and click
Edit/Delete or Command + Backspace.

Path

This allows you to select paths according to their characteristics.

• All: Selects all paths.
• Open: Selects all open paths.
• Even-Odd: Selects all paths filled using the Even-Odd fill mode. You can see the fill mode in the

Object window (see Object Window: Path).
• Non-Zero winding: Selects all paths filled using the Non-Zero Winding fill mode.
• Mixed Orientation: Selects all paths with a mixed orientation, e.g. a compound made from an

outline oriented clockwise, and one oriented counterclockwise). You can see the orientation in
the Object window (see Object Window: Path).

Text

This allows you to select text according to its characteristics.

• All: Selects all text.
• Size: Selects all text with a font size lower, equal or higher than a specified value.
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• Font: Selects all text in a specific font. To choose the font, type its name in the field on the right,
or select it in the drop-down menu.

Note:  All fonts partially matching the name you
type will be selected.

Traps

This allows you to select all traps.

4.2 Copy & Paste

4.2.1 Cut

Deletes the selected objects from the document and copies them to the clipboard.

Shortcut: Command + X (Mac) or Ctrl + X (Windows)

4.2.2 Copy

Puts a copy of the selected objects on the clipboard.

Shortcut: Command + C (Mac) or Ctrl + C (Windows)

4.2.3 Paste

Pastes all the clipboard objects in the current document. The objects are pasted at the same location
as in the original file. If the ruler is shown, the object is pasted at the same position relative to the
ruler as when it was copied or cut. Objects will be pasted at the top of the current layer. Objects can
be pasted in the original document as well as in any other document.

Shortcut: Command + V (Mac) or Ctrl + V (Windows)

4.2.4 Delete

Deletes the selected objects.

Shortcut: Command + Backspace (Mac) or Ctrl + Backspace (Windows)
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4.3 Undo & Redo

4.3.1 Undo

Undoes the last preformed action. The entire list of actions can be seen in the History window. The
number of actions that can be undone is unlimited.

Shortcut: Command + Z (Mac) or Ctrl + Z (Windows)

4.3.2 Redo

Redoes the last undone action. After doing a new action, you can't redo the previous ones anymore.

Shortcut: Shift + Command + Z (Mac) or Ctrl + Shift + Z (Windows)

4.3.3 History

The History window contains a complete undo / redo history. For more information on the History
window, see History.

4.4 Tools

4.4.1 Select Tool

The Select Tool  allows you to select objects either by clicking in them (Area select), or on their
outline (Outline select). For more informations see Selection Tool.

4.4.2 Edit Spline Tool

With the Edit Spline Tool , you can edit paths. For more details see Editing a Path.
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Double-clicking on the Edit Spline Tool opens the Object window (according to what is selected, the
Object window's name changes to “Path”, “Box”, “Ellipse”, “Star”, “Polygon”, or “Text”).

4.4.3 Cut Tool

The Cut Tool  is located under the Edit Spline Tool: hold the mouse down on the Edit Spline
Tool to show it.

It enables you to open an outline at a certain point, or cut a closed outline in two parts.

4.4.4 Transform Tool

The Transform Tool  allows you to select, move, scale and rotate objects. You can also use the
Transformation window to transform the selected objects (see Object Transformation). Double-click
the Transform Tool to open this window.

Selecting

The Transform Tool can be used to select. The cursor will be a regular arrow  and will work
like the select Tool.

Moving

Dragging

To move an object click inside the bounding box and drag. The cursor will change to a crossed arrow

.

To constrain the movement either vertically or horizontally, hold the Shift key.

Moving by Step Distance

To move an object by a predefined distance, set the Step distance in the Preferences (see Step
distance), and use the arrow keys of your keyboard.

For example if the Step distance is 5mm, pressing the right arrow key once will move the object to
the right by 5mm.

Note:  Hold the Option key (Mac) or Alt key
(Windows)to move the selected object by 10 times
the step distance.
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Snapping

To snap an object to the nearest visible page box, guide or the ruler, you can either:

• start to drag it then hold Command(Mac) or Ctrl (Windows),
• hold Command (Mac) or Ctrl (Windows) and use an arrow key.

Note:  If there isn't anything to snap to in the
direction of the arrow key you use, the object will
not move.

i-cut Preflight uses the object's handles for snapping.

In the example below, the selected object snapped to the left, to the ruler. i-cut Preflight placed the
object's left handles on the ruler (the handles used are highlighted).

Resizing

To resize (scale) the selected object(s), move the mouse over one of the eight handles and drag. The

cursor will change to a horizontal, vertical or diagonal double arrow .

Scaling is performed relative to the opposite corner or side, unless the ruler is shown. In that case,
scaling is relative to the ruler origin.

To constrain the scaling to be equal in both directions, hold the Shift key.

Rotating

Move the cursor slightly outside one of the handles  to rotate the selected object(s). The
rotation is relative to the center of the selection, or to the ruler origin if it is shown.

Hold Shift to constrain the rotation to multiples of the constrain angle. You can set the constrain
angle in the Editing Preferences (see Editing).
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Hold Command (Mac) or Ctrl (Windows) to snap to those angles when rotating the object.

4.4.5 Edit Paint Tool

The Edit Paint Tool  allows you to modify the paint of selected objects (e.g.: shadings or pattern
fill paint).

For more information see Paint Tool.

Double-clicking on the Edit Paint Tool opens the Paint window (see Fill Paint / Stroke Paint) and the
Paint Transformation window (see Fill Paint Transformation window).

4.4.6 Pan tool

The Pan tool  enables you to navigate in the current view with the cursor. For shortcuts, see
Panning.

4.4.7 Zoom Tool

The Zoom Tool  allows you to zoom in and out of the current view.

For more types of zoom, see Zooming.

4.4.8 Page Box Tool

The Page Box Tool  is used to modify the Page Boxes (see Page Box Tool).

Double-clicking on the Page Box Tool opens the Page Box Transformation window (see Page Box
Transformation window).

4.4.9 Ruler Tool

The Ruler tool  allows you to place objects accurately in the document, by dragging or snapping
them to the Ruler.
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Show / Hide Ruler

When the Ruler is shown, many functions are relative to it.

To show the Ruler, you can use:

• the Ruler Tool,
• the View/Show Ruler function,
• the Ruler button in the Ruler Transformation window,
• the R or Command + R (Mac) or Ctrl + R (Windows) shortcut.

To hide the Ruler, you can use:

• the View/Hide Ruler function,
• the Ruler button in the Ruler Transformation window,
• the Command + R (Mac) or Ctrl + R (Windows) shortcut.

Note:  The Ruler Tool or the R shortcut show the
Ruler but cannot hide it.

Ruler Tool

The Ruler Tool allows to move the Ruler. Just drag or click the mouse anywhere to move the Ruler
to that location.

Hold Shift to constrain the Ruler movement either vertically or horizontally.

Snapping

To snap the Ruler to the nearest visible page box, guide or the ruler, you can either:

• start to drag it then hold Command (Mac) or Ctrl (Windows),
• hold Command (Mac) or Ctrl (Windows) and use an arrow key.

Note:  If there isn't anything to snap to in the
direction of the arrow key you use, the Ruler will
not move.

Ruler Transformation Window

Double-click the Ruler Tool to open the Ruler Transformation window.
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Horizontal / Vertical Offset

Use the X Offset and Y Offset fields to set the horizontal and vertical position of the selection.

4.4.10 Guide Tool

The Guide Tool  is located under the Ruler Tool: hold the mouse down on the Ruler Tool to
show it.

This Tool allows you to use guides to position objects in your document.

Guides Window

Go to Window / Guides or double-click the Guide Tool to open the Guides window.

This window allows you to manage your guides.

Operations on Guides

Adding Guides

To add a horizontal guide to your document, you can either:

• double-click where you want to create it,
•

click the  button in the Guides window and enter the guide's position from the media box or
the ruler if it is shown (for example “10mm” positions the guide 10 mm above the ruler's horizontal
axis).
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To add a vertical guide to your document, you can either:

• hold Option (Mac) or Alt (Windows) and double-click where you want to create it,
•

click the  button in the Guides window and enter the guide's position from the media box
or the ruler if it is shown (for example “10mm” positions the guide 10 mm on the right of the
ruler's vertical axis).

To add a guide on a page box, a selection or the ruler:

•
click the  button in the Guides window and select “Add guides on media / crop / bleed / trim /
art box”,

•
click the  button in the Guides window and select “Add guides on selection”,

•
click the  button in the Guides window and select “Add guides on ruler”.

Selecting Guides

To select a single guide:

• click it with the Guide Tool,
• select it in the Guides window.

To select multiple guides:

• hold Shift and click each guide to select with the Guide Tool,
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• drag a rectangle over the guides to select with the Guide Tool,
• hold Shift or Command and select the guides in the Guides window.

Moving Guides

To move a guide, select it and:

• drag it with the mouse,
• use the arrow keys to move it by the step distance (see Step distance).
• hold Option and use the arrow keys to move it by ten times the step distance.
• hold Command (Mac) or Ctrl (Windows) to snap it to the nearest (visible) object, page box, other

guide, or ruler.

Rotating Guides

To rotate a guide (from horizontal to vertical and vice-versa), hold Option (Mac) or ALT (Windows)
and drag it with the mouse.

Duplicating Guides

To duplicate a guide, select it, click the  button in the Guides window and select “Duplicate
selected guides”.

Deleting Guides

To delete a guide, you can either:

• select it and press the Backspace or the Forward Delete key,
•

select it and click the  button in the Guides window.

Note:  You can move, rotate, duplicate or delete
several or all guides at once.

Showing / Hiding Guides

• To show guides, enable the “Show Guides” option in the Guides window or go to View / Show
Guides.

• To hide guides, disable the “Show Guides” option in the Guides window or go to View / Hide
Guides.

Note:  You can also use the Shift + Command +
R (Mac) or Ctrl + shift + R (Windows) shortcut to
show or hide your guides.

Creating a Guide Set

When you create guides, i-cut Preflight stores them temporarily in a “Custom”guide set.
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They are saved in the document when you save it: they will still be in the document after closing
and reopening it.

To be able to use the guides in another document:

1. Use the “Save As...” function in the “Guide Sets” list.
2. Choose a name for the guide set.

Using an Existing Guide Set

Once you have saved a guide set, you can see it in the “Guide Sets” list for all your documents.

Select it to add the saved guides to your document(s).
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Note:  If you have PitStop Pro, the “Guide Sets” list
also contains all your PitStop Pro guide sets. You
will also be ableto use your i-cut Preflight guide
sets in PitStop Pro.

Importing a Guide Set

You can import a guide set (for example saved by another user on another machine) and use it in
your documents.

To do this:

1. Select the “Import...” function in the “Guide Sets” list.
2. Browse to your guide set (“.gds”) file.
3. Give your guide set file a name (or keep its existing name).

You can now choose it in the “Guide Sets” list.

Exporting a Guide Set

You can export a guide set (and use it on another machine for example).

To do this:

1. Select the “Export...” function in the “Guide Sets” list.
2. Use the browser window that opens to save your guide set as a “.gds” file, with the name and

in the location of your choice.
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Deleting a Guide Set

To delete a guide set, select it then click the  button in the Guides window.

4.4.11 Rectangle Tool

The Rectangle Tool  allows you to draw rectangles and squares. For more information, see
Rectangle.

Double-click on it to open the Object window with rectangle parameters.

Shortcut: M

4.4.12 Ellipse Tool

The Ellipse Tool  allows you to draw ellipses and circles. For more information, see Ellipse.

Shortcut: L

4.4.13 Star Tool

The Star Tool  allows you to draw stars. For more information, see Star.

Double-click on it to open the Object window with star parameters.

4.4.14 Polygon Tool

The Polygon Tool  allows you to draw polygons. For more information, see Polygon.

Double-click on it to open the Object window with polygon parameters.

4.4.15 Pen Tool

The Pen Tool  allows you to draw custom shapes (Paths). For more information, see Paths.

Double-click on it to open the Object window with paths parameters.
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Shortcut: P

4.4.16 Type Tool

You can use the Type Tool  to create or transform a Text Box (see Text Boxes), and select a
piece of text to edit it (see Select Text).

You can also use it to link text blocks: text that no longer fits in a text block will overflow in the text
block it is linked to. See Text Linking.

Double-clicking on the Type Tool opens the Object window (called “Text” window if text is selected).

Shortcut: T

4.4.17 Text Block Tool

You can have an overview of all text blocks and edit them with the Text Block Tool : you can
easily identify, select, move, resize and link text blocks.

See Text Overview.

Shortcut: Shift + T

4.4.18 Densitometer Tool

The Densitometer Tool  shows the separation values and the total ink percentage at the mouse
location when clicking or dragging.

For more details see Densitometer Tool.

Double-clicking on the Densitometer Tool opens the View separations window.

Shortcut: I

4.4.19 Measure Tool

You can use the Measure Tool  to show the distance a particular point is from the left and
bottom of the trim box, or from the Ruler origin.

You can also use it to measure the distance from one point to another.

For more details see Measure Tool.
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5. Appearance

5.1 Fill Paint / Stroke Paint

Double-click the Paint Tool to open the Fill Paint window.

Shortcut: Command + I (Mac) or Ctrl + I (Windows)

This window defines the paint of the selected object. Click the Fill or Stroke square to bring it to the
front and define either the Fill or Stroke Paint.

You can also swap the current Fill and Stroke Paint characteristics by clicking the double sided arrow
above the squares.

For example, if the selected object has a cyan and white shading as Fill Paint and a flat black Stroke,
clicking on the double sided arrow will make it have a flat black Fill Paint and a cyan and white
shading as Stroke Paint.

The Chain icon  allows you to link the paint to the object: when you resize or move the object,
its paint will be resized or moved with it. It is activated by default. If you deactivate it, you can move/
resize the object, but the paint will remain at the same position/the same size.
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Note:

When you create a new object, it has automatically
the same fill and stroke paint as the last object you
created.

To create an object with a different fill/stroke paint,
create the object first, then change the fill/stroke
paint.

5.1.1 No Paint

The object is not filled nor stroked .

5.1.2 Flat

The normal plain color definition .

This can be CMYK as well as spot colors. You can fill in any mixture of CMYK and spot colors.

5.1.3 Shading

With Shading , the Fill Paint window shows two columns of screen percentages, allowing to define
the start and end color of the gradation. The midpoint can be set in percentage.

If shading is set to Radial, a circular shading will be generated on the bounding box of the object. If
it is set to Axial, a vertical gradation will be generated, based on the bounding box of the selection.

After the shading is generated, its position and size can be changed using the Paint Tool (see Paint
Tool).
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You can add colors to a shading by clicking underneath the preview bar. Each color can be moved
by clicking and dragging. When moving it away from the preview bar, the color will be removed from
the shading.

The values for two shading colors is shown: the selected colors, indicated by a black outline on the
preview squares. You can see the values for another color by simply clicking on it. The location can
be defined by dragging it, or by entering the location manually.

The MidPoint of every segment of the shading can be moved by moving the diamond shape on top
of the preview bar, or by entering it manually.

5.1.4 Image

If you set Fill Paint to Image , a browser window will open, allowing to select the image you want
to place. You can select a PNG, JPG, image PDF, TIFF, or PSD file.

The image compression rate is shown at the top of the window.

The File name is shown, the dimension of the image in pixels and the real resolution. The real
resolution can differ from the file resolution. A 300 dpi image scaled at 50% will show a real resolution
of 600 dpi.

To select a different image, click the Folder icon in front of the file name (this opens a browser
window).

Channel Mapping

The Separation list shows the channel mapping: by default, the channels (CMYK) are mapped in their
respective separation. You can remap any separation using the drop-down menus.

The use of an Opacity channel is explained below. The checkbox in front of the drop-down menu
allows to invert the channel.
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Opacity

If an opacity is used, the Opacity channel defines where the image is transparent or opaque: the
image is knocking out the background, with the value of the opacity channel at that place.

If the Opacity channel is 100%, the image will be knocking out completely.

If the Opacity channel is 60% at a certain place, the image will be knocking out the background for
60%, meaning 60% of the image channels will be mixed with 40% of the background.

Where the opacity channel is 0%, the image is completely transparent.

Editing an image

Double-click the preview in the Fill Paint window to edit an image in the default editing application
(e.g. Photoshop), defined in the Preferences (see Editing).

When saving the modified image in the editing application, the image in the i-cut Preflight file will
be updated immediately.

Note:  This will not alter the original image but save
a copy of the edited image in your PDF file.

These changes can still be undone in i-cut Preflight, using the regular Undo function.

You can also edit an image in the application defined in the Preferences from the Images window.
See Edit Image.

Placing an image

To place an external image in your document, use the Object/Image/Place function.

For more information see Place Image.

Exporting an image

To export an image from your document into a file, use the Object/Image/Export function.

For more information see Export Image.

5.1.5 Pattern

To Make a Pattern

To make a pattern, select the element(s) you want to use to make the pattern, then go to Object/
Pattern/Make.
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This encloses the selected objects in a box. The width and height of that box define the pattern step.

You can edit the pattern in the Fill Paint window .

Patterns in the Fill Paint Window

In the Fill Paint window, you can set the Vertical and Horizontal step for a pattern already defined.

You can also edit other characteristics of the pattern (e.g. its separations values) by double-clicking
on the Fill Square (that has a preview of the pattern).

This opens the pattern in a new window, where you can edit it. The pattern in the original window
is updated automatically.

Colored

If the Colored checkbox is on, the pattern will be filled using the colors of the original objects.

If Colored is off, you will be able to enter a flat color definition for the Pattern.

5.1.6 Overprint

When you activate this option, your paint is in overprint for every separation that isn't empty (zero or
no image channel). Overprint applies to all paint types.
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If you want to apply overprint for some separations, activate overprint for your paint, and fill K.O. or
just “K” (Knock Out) for the separations that you don't want in overprint.

The K.O. option is only available if Overprint is on.

5.1.7 Registration

If the Registration checkbox is on, all separations will get the same value. Changing the value for
one separation will apply the same value in all separations.

This uses the Registration Color Space to define registration marks.

5.2 Paint Transformation

5.2.1 Paint Tool

The Paint Tool  is similar to the Transform Tool, except that it works on paints instead of objects.
It allows you to make a selection just like the Selection and Transform Tool.

Shortcut: Shift + E

To edit either the Fill or Stroke paint, click the Fill or Stroke square in the Paint window (see Fill Paint /
Stroke Paint), then click the Paint Tool.

Flat Paint or No Paint

These cannot be edited.

Axial Shading



5
i-Cut Preflight | 5. Appearance | 65

For an axial shading, the start and end point are shown, connected by a line. You can drag either
start or end point to move it individually, or drag the line to move them both at the same time.

You can also rotate the shading around its center by moving the mouse slightly outside the start
or end point.

Rotation can be constrained to the constrain angle (see Constrain angle) using the Shift key, or
snapped to it using the Command key (Mac) or Ctrl key (Windows).

Radial Shading

For a radial shading, both the inner and outer circle are shown, together with their centers. When
first creating a Radial shading, the centers are exactly on top of each other, and the inner circle has
no radius.

Note:  For a better looking radial shading, always
keep the inner circle inside of the outer circle.

Move

To move both circles at the same time, just click and drag inside the circles.

To move one of the circles individually, first dissociate the circles' centers by dragging the center
point, then click and drag the center point of the circle you wish to move.

Resize

To resize one of the circles, click and drag the circumference of the circle. To resize the inner circle
for the first time, start dragging from slightly outside its center point.

Image
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When using the Paint Tool on an image, the image gets handles, that allow you to move, scale and
rotate it.

If the ruler is shown, its origin will be used as point of origin for the transformation.

Patterns

When transforming patterns, the single cell will get handles, and a vertical and horizontal arrow will
be shown.

The handles on the single cell allow you to move, scale and rotate the cell. If the ruler is shown, its
origin will be used as point of origin for the transformation.

The arrows allow to modify the step distance.

Mixed Paints

When objects with mixed paints are selected, the Paint Tool behaves just like the Transform Tool.

5.2.2 Fill Paint Transformation window

Double-click the Paint Tool to open the Fill Paint Transformation window.
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Using this window you can move, rotate, scale and shear an object's fill paint.

Point of Origin for the Transformation

• If the ruler is shown, the origin of the ruler is used as origin for the transformation. You can show /
hide the ruler with the ruler button

 (see also Exclude).
• If the ruler is hidden, the origin of the transformation is a point from the bounding box of the

selection. You can select this point with the Reference Point button . For example if you
select the bottom left Reference Point, the bottom left corner of the bounding box is used as
origin of the transformation. It will remain in place when scaling the selection.

Horizontal / Vertical Offset

Use the X Offset and Y Offset  fields to set the horizontal and vertical position of the
selection.

• When the ruler is shown, the position is defined relative to the ruler's origin.
• When the ruler is hidden, the position is defined relative to the bottom left corner of your

document.

Width / Height

Use the Width and Height  fields to set the width and height of the selection (in the units
defined in the Preferences, see General Units).

Use the Scale X and Scale Y  fields to scale the width and height of the selection to a
percentage of the original width / height.

Note:  You can flip (mirror) your selection by adding
a minus sign in the Scale X or Scale Y field. Use the
Scale X field to mirror your selection horizontally,
and the Scale Y field to mirror it vertically.
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Rotation

Use the Rotation  field to rotate your selection counter-clockwise.

To rotate it clockwise, use the minus sign (e.g. to rotate it clockwise by 90 degrees, type “-90”).

Shearing

Use the Shear  field to shear the selection by a certain angle.

In the example below, shearing the selection on the left by 25 degrees gives the result on the right.

By default, the selection is sheared to the right. To shear it to the left, use the minus sign.

5.3 Stroke Window

The Stroke window can be used to put a line around open orclosed paths.

The stroke has his own paint that can be defined in the Paint window.
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5.3.1 Width

The line width for the stroke. The line width is always symmetrical (the inside and the outside distance
are the same).

Cap

The caps can be Butt, Round or Square.

• With Butt caps the stroke ends exactly at the end points of a path.
• With Round caps the stroke is rounded at the end points of a path, prolonging the path slightly.
• With Square caps the stroke continues beyond the end points of the path (at a distance equal to

half of the line width) and has a square ending.

Join

The join can be Mitered, Round or Bevel. This is similar to the cap, but is applied to joined paths.

Miter Limit

A miter corner closes in one point. In order to avoid the resulting corner becoming too sharp, it can
be cut off.

The distance where the corner is cut off is controlled by the Miter Limit. When the limit is reached,
you can then have a sharp corner.

Dashed Stroke

The dashed stroke characteristics are controlled by the width of the stroke and the different Dash
and Gap values.

Note:  You can change the strokes' units in the
Preferences. See Editing.

5.4 Transparency

i-cut Preflight fully supports transparencies. This means when opening a PDF file containing
transparencies, these will remain after opening.
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The Transparency window defines the blend mode, opacity and mask to be used on the selected
objects.

5.4.1 Object / Group Transparency

The Transparency window has a button to switch between group and object transparency.

•

Object transparency : this only shows the transparency of single objects. It never shows
the transparency of groups.

•

Group transparency : this shows the transparency all selected top level objects. Most of
the time, these top level objects are groups.

Note:  When you ungroup the objects, the group
transparency is lost, and the objects regain their
original transparencies.

5.4.2 Blend Modes

A blend mode makes a combination between the base object and a blend object, resulting in a blend
color. The result depends on the base object, the blend color and the opacity.
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Normal

Normal means the blend color will simply replace the base color. At 100% Opacity, this gives the
same result as it would without any transparency.

At other percentages, this will result in a mix of the base and the blend object.

Multiply

Looks at the color information in each channel and “multiplies” the base color by the blend color.
The result color is always a darker color. Multiplying any color with black produces black. Multiplying
any color with white leaves the color unchanged. This is mostly used for shadows.

Screen

Looks at each channel's color information and multiplies the inverse of the blend and base colors.
The result color is always a lighter color. Screening with black leaves the color unchanged. Screening
with white produces white. The effect is similar to projecting multiple photographic slides on top of
each other.

Overlay

Multiplies or screens the colors, depending on the base color. Patterns or colors overlay the existing
pixels while preserving the highlights and shadows of the base color. The base color is not replaced
but is mixed with the blend color to reflect the lightness or darkness of the original color.

Soft Light

Darkens or lightens the colors, depending on the blend color. The effect is similar to shining a diffused
spotlight on the image.
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If the blend color (light source) is lighter than 50% gray, the image is lightened, as if it were dodged.
If the blend color is darker than 50% gray, the image is darkened, as if it were burned in.

Hard Light

Multiplies or screens the colors, depending on the blend color. The effect is similar to shining a harsh
spotlight on the image.

If the blend color (light source) is lighter than 50% gray, the image is lightened, as if it were screened.
This is useful for adding highlights to an image. If the blend color is darker than 50% gray, the image
is darkened, as if it were multiplied. This is useful for adding shadows to an image.

Color Dodge

Looks at the color information in each channel and brightens the base color to reflect the blend color.
Blending with black produces no change.

Color Burn

Looks at the color information in each channel and darkens the base color to reflect the blend color.
Blending with white produces no change.

Darken

Looks at the color information in each channel and selects the base or blend color (whichever is
darker) as the result color. Pixels lighter than the blend color are replaced, and pixels darker than
the blend color do not change.

This blend mode is often used for traps.

Lighten

Looks at the color information in each channel and selects the base or blend color (whichever is
lighter) as the result color. Pixels darker than the blend color are replaced, and pixels lighter than
the blend color do not change.

Difference

Blend object color and Base object color are subtracted from one another and the absolute value is
taken. This blend mode has no effect on spot colors.

Exclusion

Creates an effect similar to but lower in contrast than the Difference mode. Blending with white inverts
the base color values. Blending with black produces no change. This blend mode has no effect on
spot colors
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Hue

Creates a result color with the luminance and saturation of the base color and the hue of the blend
color.

Saturation

Creates a result color with the luminance and hue of the base color and the saturation of the blend
color. Painting with this mode in an area with no (0) saturation (gray) causes no change.

Color

Creates a result color with the luminance of the base color and the hue and saturation of the blend
color. This preserves the gray levels in the image and is useful for coloring monochrome images and
for tinting color images.

Luminosity

Creates a result color with the hue and saturation of the base color and the luminance of the blend
color. This creates an inverse effect from the Color mode.

Note:  After you applied a blend mode to an object,
the next object you create will have this blend
mode applied too. If you don't want this blend
mode for the new object, you need to change it
after you created the object.

5.4.3 Opacity

Defines how much of the blend result will be used. If the opacity is 100%, the result will be 100%
of the blend result.

5.4.4 Mask

If the object selected has a mask applied, it will be shown here.
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Opacity Mask

Making an Opacity Mask

Select the front and back objects you want to use for your opacity mask.

Go to Object/Opacity Mask/Make, or use the shortcut Cmd + 6 (Mac) or Ctrl + 6 (Windows).

The front object becomes an opacity mask on the other selected object(s).

If you have several back objects, i-cut Preflight puts them in a new group, that gets the front object
as an opacity mask.

Both the opacity mask object and the other objects remain fully editable.

Shortcut: Cmd + 6 (Mac) or Ctrl + 6 (Windows)

Note:  If you want more than one object as opacity
mask, you should group these objects first.

Note:  If you selected only one object, that object
will get an empty opacity mask (you can edit it in
the Transparency window).

Releasing an Opacity Mask

To remove the opacity mask from a group or object, go to Object/Opacity Mask/Release, or use
the shortcut Cmd + Option + 6 (Mac) or Ctrl + Alt + 6 (Windows). The opacity mask will become a
normal object.

Editing an Opacity Mask

To edit an opacity mask, double-click its preview in the Transparency window. It will be opened in
a new window, where you can edit it.

All changes are applied immediately, and the result can be seen in the main job window.

Stencil Mask

You can see if an object has a stencil mask in the Transparency window .
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Stencil masks (e.g. created by Illustrator you make a colored bitmap) are kept as stencil masks and
no longer converted to opacity masks.

You cannot create or edit stencil masks in i-cut Preflight.

Note:

After you applied a mask to an object, the next
object you create will have this mask applied too.

If you don't want this mask for the new object, you
need to change it after you created the object.

5.4.5 Clip

The Clip option allows to clip the masked object using its associated opacity mask. Clipping is always
on for stencil masks.

5.4.6 Invert

The Invert option allows to invert the opacity or stencil mask before applying it.

5.4.7 Isolate Blending

This option is only available for group transparency.

When an object has a blend assigned to it, it will affect all objects underneath.
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Enable this option to apply the blending to objects within the group only, and not to other objects
underneath.

5.4.8 Knockout Group

This option is only available for group transparency.

Enable this option to calculate the opacity and blend between the group's topmost object and the
group's background (and not between objects inside the group).

5.4.9 Opacity & Mask define Knockout Shape

This affects only a combination of objects with an opacity mask, inside a group with the Knockout
Group option.
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5.5 Appearance Window

The Appearance window contains all the parameters defining the appearance of an object: the Fill
Paint, the Stroke Paint and the Transparency.

When you select an object, it shows the appearance parameters of this object.

5.5.1 Defining an Appearance

You can define an appearance in the Appearance window in two ways:

• Select an object that has this appearance in your document.
• Deselect any object that might be selected and use the Fill Paint, Stroke Paint and Transparency

windows to define an appearance.
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Note:

• Double-click the “Fill” square to open the Fill
Paint window,

• double-click the “Stroke” square to open the
Stroke Paint window,

• double-click the “Trans.” field to open the
Transparency window.

Setting the Appearance to Default

Use the “Restore Default Appearance” button  at the bottom right of the window to set the Fill
paint to White, the Stroke to a black two-point-wide stroke, and the Transparency to “Default”.

Selecting all Objects with a Certain Appearance

Once you have defined an appearance, enable the Arrow icons in front of the parameters you want
to select and click the “Select by appearance” arrow at the bottom right of the window.

In the example below, clicking the “Select by appearance” arrow will select all Cyan objects with no
stroke, without taking into account their transparency.

Note:  Click the arrow at the bottom left to enable /
disable all the appearance parameters' arrows.

Applying an Appearance to Objects

Once you have defined an appearance, enable the Paint Bucket icons in front of the parameters
you want to apply and click the “Apply Appearance to selection” paint bucket at the bottom right
of the window.

In the example below, clicking the “Apply Appearance to selection” paintbucket will apply a Soft
Light transparency to all selected objects, but will not change their fill or stroke paint.
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Note:  Click the paint bucket at the bottom left to
enable / disable all the appearance parameters'
paint buckets.
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6. Objects

6.1 Shapes

You can choose different shapes by holding the mouse down on the Rectangle tool .

The available shapes are: Rectangle, Ellipse, Star and Polygon.

Each shape created gets the current appearance (Fill and Stroke paint).

See:

• Rectangle
• Ellipse
• Star
• Polygon

Note:  You can also draw custom shapes (Paths)
with the Pen Tool. See Paths

6.1.1 Rectangle

Drag the cursor with the Rectangle Tool to make a rectangle. Hold Shift while dragging to make a
square.

Double-click the Rectangle Tool to open the Object window (called “Rectangle”in this case), in which
you can change the rectangle's parameters.

Corners

You can change the corner type to:

• “Square” (default),
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• “Round”,

• “Cut”,

• “Antique”.
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Radius

The Radius (for Round, Cut and Antique corners) determines the relative size of the corners, in a
percentage of half of the smallest side.

6.1.2 Ellipse

Drag the cursor with the Ellipse Tool  to make an ellipse. Hold Shift while dragging to make
a circle.

6.1.3 Star

Drag the cursor with the Star Tool  to make a star. The starting point will be its center, and
the end point will be its top.

To constrain the star to the constrain angle, hold the Shift key.

Double-click the Star Tool to open the Object window (called “Star” in this case), in which you can
change the star's parameters (number of points, inner radius and phase).

Points

The Points define the number of star tips (5 by default).

Phase

The Phase gives the rotation of the star relative to the horizontal axis.
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Inner radius

The Inner radius defines the scale factor of the inner circle, on which the inner star points are
positioned, in relation to the outer circle on which the star tips are set. The smaller this ratio, the
sharper the star will be.

Note:  You can only edit the star parameters
in the Star window if you have a star object
selected. Create a default star before changing the
parameters.

6.1.4 Polygon

Drag the cursor with the Polygon Tool  to make a polygon. The starting point will be its center,
and the end point will be its top.

To constrain the polygon to the constrain angle, hold the Shift key.

Double-click the Polygon Tool to open the Object window (called “Polygon” in this case), in which
you can change the polygon's parameters.

Points

Enter the number of points you want your polygon to have.
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Phase

The Phase gives the rotation of the polygon.

6.2 Paths

6.2.1 Drawing a Path

Hold the mouse down on the Rectangle Tool to get the Pen Tool .

Shortcut: P

Click or drag your cursor to begin a new path.

Adding New Straight Line Segments

• To add a new straight line segment, click where you want the segment to end.
• To add a straight line at right angle, hold Shift and click.
• To add a straight line segment after a curve, click on the last point of the curve then click where

you want the end of your straight line to be.

Adding New Curve Segments

• To add a new curve segment, drag the mouse.



6
i-Cut Preflight | 6. Objects | 85

• To add a new curve segment and to control the curvature at the starting point too (for example
to get the paths below), do the following:

1. Click on the last point of the last segment you have drawn, then without lifting the mouse, drag
a handle in the direction you want the curve to go.

Note:  This handle will not be visible in the final
path.

2. At the end of the handle, lift the mouse then position the cursor where you want the end point
of your curve to be and click (or drag to get a handle at the end).

Removing the Last Added Point

Use BACKSPACE or Command + Z (Mac) or Ctrl + Z (Windows) to remove the last point of the path.



6
86 | i-Cut Preflight | 6. Objects

Finishing a Path

To close a path, click the starting point again, use Object/Path/Join, or use the shortcut Command
+ J (Mac) or Ctrl + J (Windows).

To leave a path open, press ENTER or switch to another tool.

6.2.2 Editing a Path

To edit a path, click the Direct Selection Tool  then the path you want to edit.

Shortcut: A

Note:  You can Option-click (Mac) or Alt-click
(Windows) to change the Direct Selection Tool's
selection mode (outline or area).

When a path is editable, it shows control points for its straight lines, and control points with handles
for its curves.

Add / Remove

To add a control point, double-click a line / curve.

To remove a control point, select it and press BACKSPACE.

Move

To move a control point, drag it (straight line), or drag its handle (curve).

Curvature

• To edit a curve's curvature at a control point, moveone of the point's handles.
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• To edit the opposite curvature as well (to preserve smoothness), first click the control point, and
then drag either handle. The opposite handle will move too.

• To toggle between a sharp (line) and a smooth (curve) control point,double-click it.

Selecting Multiple Control Points

You can edit more than one control point: drag a rectangle around the control points you want to
select.

You can also click inside an outline to select all of that outline's control points.

To remove control points from the selection, hold Shift and drag a rectangle around the control points
to deselect.

To delete all the selected control points, press BACKSPACE.

To move them, drag one of them.

6.2.3 Joining Paths

The Join function (Object/Path/Join) closes a single open path, or can join all selected open paths
and make one closed path from them.

Gaps between the open paths will be bridged by straight line segments.

Shortcut: Command + J (Mac) or Ctrl + J (Windows)

6.2.4 Converting to a Path

Convert to Path (Object menu/Path/Convert to Path) converts all selected objects to plain groups
and paths. This is especially useful for text blocks.

6.2.5 Object Window: Path

Double-click the Direct Selection Tool to open the Object window (called “Path” in this case).
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When a path is selected, you can define its Fill mode and Orientation in this window.

The Fill mode can be Non-Zero Winding Fill (see picture on the left) or Odd-Even Fill (see picture
on the right).

The Orientation (e.g. when adding points to an open path) can be clockwise or counterclockwise.

6.3 Object Transformation

6.3.1 Object Transformation Window

Double-click the Transform Tool to open the Object Transformation window.

Using this window you can move, rotate, scale and shear a selection (object or group of objects).

Note:  The objects' paint will be transformed
together with the objects.

You can also use the Transformation window to transform other elements of your design:

• To move the Fill Paint only (and not the rest of the object), selectthe Paint Tool. See Fill Paint
Transformation window.

• To move the Stroke Paint only (and not the rest of the object), select the Paint Tool and click the
Stroke square in the Paint window. See Fill Paint / Stroke Paint.
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• To modify the Page Boxes, select the Page Box Tool. See Page Box Transformation window.
• To move the Ruler, select the Ruler Tool. See Ruler Transformation Window.

Point of Origin for the Transformation

• If the ruler is shown, the origin of the ruler is used as origin for the transformation. You can show /

hide the ruler with the ruler button  (see also Ruler Tool).
• If the ruler is hidden, the origin of the transformation is a point from the bounding box of the

selection. You can select this point with the Reference Point button . For example if you
select the bottom left Reference Point, the bottom left corner of the bounding box is used as
origin of the transformation. It will remain in place when scaling, rotating or shearing the selection.

Horizontal / Vertical Offset

Use the X Offset and Y Offset  fields to set the horizontal and vertical position of the
selection.

• When the ruler is shown, the position is defined relative to the ruler's origin.
• When the ruler is hidden, the position is defined relative to the bottom left corner of your

document.

Width / Height

Use the Width and Height  fields to set the width and height of the selection (in the units
defined in the Preferences, see General Units).

Use the Scale X and Scale Y  fields to scale the width and height of the selection to a
percentage of the original width / height.

Note:  You can flip (mirror) your selection by adding
a minus sign in the Scale X or Scale Y field. Use the
Scale X field to mirror your selection horizontally,
and the Scale Y field to mirror it vertically. You
can also mirror horizontally or vertically using the
functions in  Object > Transform . See Mirror
objects

Rotation

Use the Rotation  field to rotate your selection counter-clockwise.

To rotate it clockwise, use the minus sign (e.g. to rotate it clockwise by 90 degrees, type “-90”).
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Shearing

Use the Shear  field to shear the selection by a certain angle.

In the example below, shearing the selection on the left by 25 degrees gives the result on the right.

By default, the selection is sheared to the right. To shear it to the left, use the minus sign.

6.3.2 Mirror objects

You can mirror the selected objects vertically or horizontally, by selecting the objects, and choosing
Object > Transform > Mirror Vertically or  Object > Transform > Mirror Horizontally

The selected object(s) will be mirrored around the center of the bounding box.

6.3.3 Scissors Tool

The Scissors Tool  becomes available by holding the mouse down on the Direct Selection
Tool. It allows you to either open an outline at a certain point, or cut a closed outline in two parts.

Shortcut: C

To Open an Outline

1. Select the outline with the Direct Selection Tool.
2. With the Scissors Tool, double-click the point where you want to open it.
3. With the Direct Selection Tool, move this point away from the rest of the outline.
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To Cut a Closed Outline in Two Parts

1. Select the outline with the Direct Selection Tool.
2. With the Scissors Tool, click the first point.
3. Click the second point.
4. Pull one of the parts away from the other one.

Note:  To delete the part of the object you have cut
out, click it with the Scissors Tool and press the
Backspace key.

Note:

The Scissors Tool doesn't create new objects, but
makes a compound of the current object.

If you want to get two separate objects after
cutting, select the compound and either go
to menu Object/Compound/Release, or press
Option + Shift + Command + 8 (Mac) or Ctrl + Alt
+ 8 (Windows).

For more information on compounds, see
Compound Path.
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6.4 Operations on Several Objects

6.4.1 Align

The Align function can be used to horizontally or vertically align or distribute a number of objects.

The first row is to align or distribute all objects vertically, the second row to align or distribute all
objects horizontally.

The first button aligns all object to the top of the bounding box (of the selection), the second to the
center, the third to the bottom.

The two following buttons allow to divide the center points, or to divide the space in between.

6.4.2 Compound Path
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Make

Makes a compound path of the selected objects. With Make Compound, all selected paths will
become one single object.

The compound is inserted at the location of the topmost object.

Where paths are overlapping, a look-through window to the background is created.

As a compound is one object, it can have only one color, so when paths with different colors are
compounded, they will be filled with the color of the topmost object.

Shortcut: Command + 8 (Mac) or Ctrl + 8 (Windows)

Release

Releases a compound path. A new path will be made for every outline in the compound.

Shortcut: Option + Shift + Command + 8 (Mac) or Ctrl + Shift + 8 (Windows)

Selecting a Path from a Compound

To select and / or move a path inside a compound, use the Direct Selection Tool and select all anchor
points.

6.4.3 Group

Make

All the selected objects will be put in a new group. The group is created at the location of the topmost
object, so some objects may come forward.

All objects in the group will keep their own color and individual order.

Shortcut: Command + G (Mac) or Ctrl + G (Windows)
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Release

Removes the selected groups while keeping all of the objects that were inside the groups.

If the group had transparency or clipping paths, these will be lost.

Shortcut: Shift + Command + G (Mac) or Ctrl + Shift + G (Windows)

6.4.4 Clipping Mask

Make

The frontmost selected object will be used to clip all other selected objects. They will be put in a
new group together with the clipping object.

Both the clipping object and the other objects still remain fully editable.

Shortcut: Command + 7 (Mac) or Ctrl + 7 (Windows)

Release

Release the clipping objects of the selected groups. All clipping objects will become normal objects
again.

Shortcut: Option + Command + 7 (Mac) or Ctrl + Alt + 7 (Windows)

6.4.5 Unite

Unites the selected objects, using the foreground paint. These objects may come from different
layers or groups.

The union replaces the selected objects and is sent to the layer of the object that was on top.
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6.4.6 Intersect

Intersects the selected objects using the foreground paint.

This takes groups (and text) into account, meaning that groups will be seen as a whole, so the objects
in a group will not intersect each other, but only intersect other objects or groups.

The objects may come from different layers or groups. The intersection replaces the selected objects
and is sent to the layer of the object that was on top.

6.4.7 Exclude

Performs a unite minus intersection, which results in all areas that belong to exactly one object.

Just like Intersect, Exclude takes groups into account. The resulting objects take the foreground
paint, and are placed in the layer of the top object.

6.4.8 Back minus Front

All higher selected objects are subtracted from the lowest one. Groups are taken into account (see
Intersect on page 95).

The resulting object takes the background paint, and is placed in the layer of the lowest object.
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6.4.9 Front minus Back

All lower selected objects are subtracted from the highest one. Groups are taken into account (see
Intersect on page 95).

The resulting object takes the foreground paint, and is placed in the layer of the highest object.
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7. Text

7.1 Text Detection

i-cut Preflight will try to detect text words, lines, paragraphs and boxes automatically.

It can detect paragraphs in 3 orientations: standard roman, vertical, or vertical with standard roman
alignment. See Orientation.

Note:

For PDF files that contain text objects in a random
order (e.g. if the file has been flattened), the
paragraph / line / word recognition will fail, and text
editing will be much more difficult.

7.2 Edit Text

7.2.1 Select Text

Only the Type Tool  allows you to select a piece of text. All other tools will always select the
entire text block. There are several ways to select a piece of text:

• Drag the mouse to select a consecutive piece of text.
• Click in the text to position the cursor, then hold Shift and click somewhere else.
• Double-click to select an entire word.
• Triple-click to select a paragraph.
• Quadruple-click to select the entire block (also Command + A (Mac) or Ctrl + A (Windows)).

Type Tool Shortcut: T

7.2.2 Edit Text

Just type to edit text. You can also copy and paste text between i-cut Preflight and any other
application.
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In certain cases, text editing may be restricted, or you may not be able to edit the text at all, due
to font issues (see Editing Issues).

7.2.3 Search and Replace Text

Go to Edit/Find to perform search and replace on your document's text. You have several options:

Find

Use the Find function to find a particular piece of text, in all text blocks of the current page.

Note:  The Find function takes linked text blocks
into account. If a word is split across two linked
text blocks, it will still be found as one word.

Going to Edit/Find or using the shortcut opens the Find bar at the top of the document window. This
contains most of the functions of the Edit/Find submenu, as well as some options to refine the search.

At first, the Find bar only shows the Find functionality. Click the grey triangle  near Find to show
the Replace functionality too.

Shortcut: Command + F

Click the small triangle inside the search field to show more options:
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Ignore Case

By default, the search is case-insensitive ("Ignore Case" is selected). Deselect it to make the search
case-sensitive.

Wrap Around

Select this option if you want the text to continue at the beginning of the page after it has reached
the end (for example if your cursor is mid-way through a text field).

This is selected by default.

Contains / Starts With / Whole Words

Choose if you want i-cut Preflight to find:

• pieces of text that contain what you entered in the Find field (this is the default option),
• pieces of text that start with what you entered in the Find field,
• whole words that match what you entered in the Find field.

Find Next

Use this to find the next piece of text matching what you entered in the Find field.

All the Find options you set in the Find dialog (Ignore Case, Warp Around, Contains...) are applied.

Shortcut: Command + G

Find Previous

Use this to find the previous piece of text matching what you entered in the Find field.

All the Find options you set in the Find dialog are applied.

Shortcut: Shift + Command + G
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Find All

Use this to find all the pieces of text matching what you entered in the Find field.

All the Find options you set in the Find dialog are applied.

Shortcut: Option + Command + G

Replace All

Use this to replace all of the matching pieces of text found.

Shortcut: Option + Shift + Command + L

Replace and Find

Use this to replace the matching piece of text found, and find the next match.

All the Find options you set in the Find dialog are applied.

Shortcut: Command + L

Use Selection for Find

Use this to copy your selection into the Find field of the Find dialog.

Note:  This doesn't use the paste board, so items
you have previously copied can still be pasted.

Shortcut: Command + E

Use Selection for Replace

Use this to copy your selection into the Replace field of the Find dialog.

Note:  This doesn't use the paste board, so items
you have previously copied can still be pasted.

Shortcut: Shift + Command + E

Example 1

You want to replace "apple" by "orange" (and "apples" by "oranges") in your document.

1. Go to Edit/Find/Find (or use Command + F) and type "apple" in the Find field of the Find dialog.

Note:

You can also select the word "apple" in your
document and go to Edit/Find/Use Selection for
Find (or Command + E).

Note that this doesn't open the Find dialog.

2. If necessary, use options to refine your search. For example:
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• Select "Ignore Case" so the word "Apple" will also be found.
• Select "Wrap Around" so words at the beginning of the page will also be found (for example

if your cursor is mid-way through a text field).
• Choose "Start With" so the search will find "apples" as well as "apple".

Note:  Do not choose "Contains" if you
don't want "pineapple" to be replaced with
"pineorange"!

3. Type "orange" in the Replace field of the Find dialog.

Note:  You can also select the word "orange"
in your document and go to Edit/Find/Use
Selection for Replace (or Shift + Command + E).

4. If you want to:

•
check each occurrence as it is replaced: Use the Next button  (or Command + G) then the
Replace & Find button (or Command + L).

• replace all occurrences at once: use Replace All (or Option + Shift + Command + L).

Example 2

You want to put all occurrences of "lorem ipsum" in italics.

1. Go to Edit/Find/Find (or use Command + F) and type "lorem ipsum" in the Find field of the Find
dialog.

Note:

You can also select the word "lorem ipsum"
in your document and go to Edit/Find/Use
Selection for Find (or Command + E).

Note that this doesn't open the Find dialog.

2. If necessary, use options to refine your search. For example:

• Select "Ignore Case" so "Lorem ipsum" and "Lorem Ipsum" will also be found.
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• Select "Wrap Around" so words at the beginning of the page will also be found (for example
if your cursor is mid-way through a text field).

3. Click the All button (or use Option + Command + G) to find (and select) all occurrences in the text.

4. Open the Text window and make those occurrences italic.

7.3 Text Properties

Double-click the Type Tool to open the Object window (called“Text” when text is selected), which
contains the text properties.
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Make sure that no other object is selected, or the Object window will show “Mixed Object”.

Expand the Text window with the green button to see all the text properties.

If different parts of the text have different properties, the corresponding fields will be blank.

7.3.1 Font

The top part of the text properties allows to set the Font, Face, type size, leading (in the Text unit as
set in the Preferences, or “Auto”), kerning, horizontal scaling, and baseline shift.

7.3.2 Paragraph

Using the buttons underneath, the alignment can be set to Left, Right, Centered, Justify all lines and
Justify only full lines. When using Justify all lines, even the last line of text will be justified.

The fields underneath define the indents: Left indent, Right indent, First line indent, and First line gap
(space before paragraph).

The last input field (Drop cap number of lines) allows to set a capital at the start of the text block,
over the number of lines defined.
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Word and Character Spacing values can be set, to be used when justifying text.

7.3.3 Hyphenation (Mac OS X only)

You can use automatic hyphenation in text blocks. If i-cut Preflight detects a hyphen in the text block,
the hyphenation will automatically be switched on.

The hyphenation rules are defined in the Mac OS, and are language independent. If some
hyphenation is incorrect or unsatisfactory, you can manually edit the hyphenation in certain words
by control-clicking the word.

7.3.4 Language (Spell Checker)(Mac OS Only)

If “Check spelling” is enabled in the extended View Options window (see View Options Window), i-
cut Preflight will automatically detect the text language and check the spelling of the words.

You can see and change the language in the Text window, but you can only set/change it for a
complete paragraph.

The languages and text spelling dictionaries are provided with your Mac OSX operating system.
When editing text, control-click any word to get a list of spelling suggestions. Choose a suggestion
in the list to change the selected word.

7.3.5 Orientation

i-cut Preflight can detect and edit paragraphs that have one of those three orientations:

• standard roman,

• vertical,

• vertical with standard roman alignment.
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You can use vertical text for numbers in a Japanese or Chinese text (see picture on the left below)
and vertical text with standard roman alignment for Japanese or Chinese characters (see picture on
the right below).

7.4 Text Boxes

Use the Type Tool  to create or transform a Text Box.

7.4.1 Create Text Box

To create a Text Box, drag a rectangle with the Text Tool.

7.4.2 Transform Text Box

To move a Text Box, place the cursor over any of its sides (it becomes a crossed arrow )
and drag it.

Hold Command (Mac) or Ctrl (Windows) while dragging to make the Text Box snap to the nearest
visible page box, guide, or the ruler.

To resize a Text Box, drag one of its handles (when the cursor is a double arrow). All text in the box
will automatically be re-wrapped.
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A Text Box will always contain the entire text. If you resize the box or add text in it, it will expand
downwards if necessary.

7.4.3 Split and Assemble Text Blocks

If text blocks are defined incorrectly in your file (e.g. if two different articles are recognized as one
text block), you can correct this withi-cut Preflight.

You can split the text block into its original objects components, and then create new text blocks
from those components.

Splitting Text Blocks

To split a text block into its original objects components (letters, words or lines depending on how
the original PDF was created), select it with the Selection or Transform Tool, and go to Object/Text/
ReleaseText Block.
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Reassembling Text Blocks

To make a new text block out of original text objects components (after splitting a text block), select
the part of the text to make into a text block with the Selection or Transform Tool, and go to Object/
Text/MakeText Block.

7.5 Text Linking

You can use the Type Tool to link text blocks: text that no longer fits in a text block will overflow into
the text block it is linked to.

To do this, click the blue arrow beside the text block, and drag it into the text block you want to
link the first one to.
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Note:  You cannot create loops (link a text block
to a second one and then the second one back to
the first one).

To unlink the text blocks, drag the arrow into the background.

7.6 Text Overview

Hold the mouse down on the Type Tool to select the Text Block Tool . With this tool, you can
have an overview of all text blocks and edit them.

Shortcut: Shift + T

Click in a text block to select it. You can then move it, resize it or link it to another text block.
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7.7 Font Issues

The font's embedding and license characteristics may cause viewing or editing issues. See also
Embedding and License.

7.7.1 Viewing Issues

If a font is not embedded in the PDF you're trying to view, or is only embedded as a subset, this
may cause viewing problems.

Missing Glyph Symbols

If the font is not embedded, and you don't have a system font of the same name, the text in that font

will be shown as missing glyph symbols ( ).

Text Reflow

If the font is not embedded, or embedded as a subset, and you do have a system font of the same
name, but with slightly different characteristics, the text will be displayed. However, its appearance
may be altered, and it may have to be reflowed inside the text box.

7.7.2 Editing Issues

If you can view the font, but it doesn't carry sufficient editing permissions (see License), you will only
be able to edit it partially, or not at all.

No Editing Possible

If the font license is “Viewing”, you can't edit the text at all.

Editing Restrictions

If the font has a “System” license (you have the font on your system), you can edit the text without
restrictions.

However, if the font license is “Editable” (you have permissions but don't have the font on your
system), editing can be restricted in some cases:

• If the font is only embedded as a subset, editing is restricted to the characters included in the
subset. You can delete and type those characters, but if you type non-subset characters, they

will be shown as missing glyph symbols ( ).
• If the font is fully embedded, but you type characters not defined in the font (e.g.:  foreign

characters or special characters), they will be shown as missing glyph symbols. You should switch
to a font that has these characters to show them correctly.
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Unknown License

In some cases, i-cut Preflight cannot determine if you have a license for a particular font or not. When
trying to edit text in this font, i-cut Preflight will ask you if you have a license for it.

If you do, you can click “Yes” and start editing the text.
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8. Layers

8.1 Layers Window

8.1.1 View Layers

You can show, lock and print layers individually.

• To show / hide a layer, click the eye icon in front of the layer name.
• To lock / unlock a layer, click the lock icon in front of the layer name.
• To make a layer printable / exclude it from printing, click the printer icon in front of the layer name.

Note:  Hold Option (Mac)or ALT (Windows) while
clicking on the eye, lock or printer icon to apply
that action to all the layers on the same level
(show/ hide, lock / unlock, or make printable /
exclude from printing).

Current Layer

A pencil icon  on the right of the layer name indicates that this layer is the current layer. This
means that if you create a new object, it will be placed at the top of this layer.

When you create a new document, there is only one layer, which is the current layer. When you have
several layers, you can make one of them the current layer by clicking in the square on the right.

Note:  Making a layer current doesn't select it, and
you can still select and edit objects in layers which
are not the current layer.
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Selected Layer

A blue square next to the layer indicates that this layer (and all of the objects it contains, or at least
one of its objects) is selected.

Nested Layers

Depending on the application that created the PDF, its layers can be “nested”.

In this case, it is possible that one object of Layer 1 is on top of Layer 2, while another object of
Layer 1 is underneath Layer 2.

Sort Front to Back

This option  allows to see the contents of a layer in a tree structure.

Click the triangle in front of a layer to view this layer's contents. You can also expand groups, and
see their contents in a tree structure.

In this case a layer name can appear more than once in the list, to show the correct nesting order
(see Nested Layers).
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Sort by Name

 The layers are ordered by name, so you don't have a tree structure.

Each layer name is shown only once.

Note:  This may not reflect the correct order.

Scroll to Selection

 Shows the position of the object you selected in the document within the layer structure.

8.1.2 Edit Layer Name

To edit a layer's name, double-click it and type the new name.

8.1.3 New Layer

A new layer can be added by clicking the New Layer button . The Layer will be named “Layer n”
automatically. You can change the name by double-clicking it (see Edit Layer Name).

8.1.4 Delete Layer

You can delete a layer by selecting it (i.e. clicking where the blue square should be, see View Layers),

and clicking on the “Delete layer” button .

You can only delete the current layer if your document contains other layers.

8.1.5 Send to Current Layer

When you click the “Send to current layer” button , the selected object(s) will be moved to the
top of the current layer (see Current Layer).

8.1.6 Make Clipping

In the "Sort front to back" view, the contextual menu of an object contains the option "Make Clipping":
this allows to clip with the selected object. It only clips objects of the same group / layer.
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8.2 Arrange Objects in Layers

8.2.1 Bring to Front

Brings the selected objects to the top of their layer (or group). The relative order of the selected
objects will not change.

Shortcut: Shift + Command + ] (Mac) or Ctrl + Shift + ] (Windows)

8.2.2 Bring Forward

Moves the selected objects one level upwards in the layer (or group). The relative order of the selected
objects will not change.

Shortcut: Command + ] (Mac) or Ctrl + ] (Windows)

8.2.3 Send Backward

Moves the selected objects one level downwards in the layer (or group). The relative order of the
selected objects will not change.

Shortcut: Command + [ (Mac) or Ctrl + [ (Windows)

8.2.4 Send to Back

Sends the selected objects to the bottom of their layer (or group). The relative order of the selected
objects will not change.

Shortcut: Shift + Command + [ (Mac) or Ctrl + Shift + [ (Windows)

8.2.5 Lock

Locks the selected objects. Locked objects are shown in gray in Outline view mode. Objects can
also be (un)locked individually in the Layers window. See View Layers.

Shortcut: Command + 2 (Mac) or Ctrl + 2 (Windows)

8.2.6 Unlock All

Unlock all locked objects.
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Shortcut: Option + Command+ 2 (Mac) or Ctrl + Alt + 2 (Windows)

8.2.7 Hide

Hide the selected objects. They are no longer visible, and thus cannot be selected or edited. Still
they are saved with the file so they will become visible again, when the file is next opened.

Objects can also be hidden and shown individually in the Layers window. See View Layers.

Shortcut: Command + 3 (Mac) or Ctrl + 3 (Windows)

8.2.8 Show All

Makes all hidden objects visible again.

Shortcut: Option + Command+ 3 (Mac) or Ctrl + Alt + 3 (Windows)
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9. Document

9.1 Document Information

Go to Window/Document to open the Document window, containing information about your
document.
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9.1.1 Info

This section contains metadata: the file's author, and the title, subject and keywords the author gave
to the file (if any).

9.1.2 File

This section contains general file information: the file name, PDF version, size and number of pages.

9.1.3 History

This contains information about the file's creation and modification: creator application, PDF
producer (PDF generation engine, which could be part of the creator application or not), date of
creation and modification of the file, and number of Certified PDF sessions.

9.1.4 Security

This shows the file's security options:

Ownership

This shows the file's owner. The double arrows allow you to set a permissions password if you own
the file or if it has no owner.

Encryption

This shows the file's encryption method. The double arrows allow you to change it.

Note:  If there is a password set for the file, you
will be asked for it when changing the encryption
method.
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Restrictions

If you have set a password, this allows you to restrict what users without the password can do with
the file.

9.2 Esko Normalized PDF

Esko Normalized PDFs are PDF files containing metadata that can be read by some workflows and
applications (e.g. Asset Management systems, Quality Control tools...), without needing to open the
file.

You can see if your file is a Normalized PDF or not in the Document window (Window/Document),
in the File section.

When editing a Normalized PDF in i-cut Preflight, it will de-normalize it and remove its normalized
label. This ensures that when putting the file back into a Normalized workflow, it will be treated as
a non-normalized file (and re-normalized if necessary).

9.3 Pages

9.3.1 Insert Page

The Insert Page function in the Document menu allows to insert one or more pages into the current
document.
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Insert

You can insert an empty page, or one or more pages from a PDF file.

Where

Here you can choose where to insert the chosen page(s):

• Beginning of document: Before the first page.
• Before page: Before the chosen page.
• On top of page: Merge with the chosen page. This option will only be available when inserting

from an existing PDF file (see above). It is also only possible to insert a single page.
• After page: After the chosen page
• End of document: After the last page.

9.3.2 Extract Page

Extract Page in the Document menu allows to extract one or more pages from the current document.
The extracted pages will be added to a new document.

You can also choose to delete the original pages after they have been extracted. This only works
when not all pages are extracted.
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9.3.3 Delete Page

Deletes one or more pages from the current document using the Delete Page function in the
Document menu. Deleting all pages is not possible.

9.4 Page Boxes

9.4.1 Page Box Tool

The Page Box Tool  edits the page boxes. The Page Box Tool behaves a lot like the Transform
Tool, except that page boxes cannot be rotated.

You can view page boxes in the View Page Boxes window (see View Page Boxes Window).

You can edit them either manually or in the Transformation window (see Page Box Transformation
window).
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Move

Drag inside the page box to move it.

Hold Shift to constrain the movement horizontally or vertically.

Hold Command (Mac) or Ctrl (Windows)while dragging to make the movement snap to the selection,
the nearest visible page box, guide, or the ruler.

You can also enter the position of the page box can also be entered in the Transformation window
(see Page Box Transformation window).

Resize

Drag one of the page box's handles to resize it.

Hold Shift to constrain the scaling to be equal in both directions.

Hold Command (Mac) or Ctrl (Windows) to snap to the selection, the nearest visible page box, guide,
or the ruler.

You can also edit the size of the selected page box in the Transformation window (see Page Box
Transformation window).

9.4.2 Page Box Transformation window

Double-click the Page Box Tool to open the Page Box Transformation window.

Point of Origin for the Transformation

• If the ruler is shown, the origin of the ruler is used as origin for the transformation. You can show /

hide the ruler on or off with the ruler button  (see also Exclude).
• If the ruler is hidden, the origin of the transformation is a point from the bounding box of the

selection. You can select this point with the Reference Point button . For example if you
select the bottom left Reference Point, the bottom left corner of the bounding box is used as
origin of the transformation. It will remain in place when scaling the selection.
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Horizontal / Vertical Offset

Use the X Offset and Y Offset  fields to set the horizontal and vertical position of the page
box.

• When the ruler is shown, the position is defined relative to the ruler's origin.
• When the ruler is hidden, the position is defined relative to the bottom left corner of your

document.

Width / Height

Use the Width and Height  fields to set the width and height of the page box (in the units
defined in the Preferences, see General Units).

Current

The Current box is the page box being shown and edited. You can also see this box in the View Page
Boxes window (it is highlighted).

Size

The Size drop-down menu allows you to change the size and position of the currently selected page
box.
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To... choose...

delete the current page box "Undefined".

Note:  You cannot
delete the Media box (it
is always defined).

fit the current page box to the selection "Fit on Selection".

fit the current page box to another one of the
document's page boxes

another document page box ("Media Box",
"Crop Box"... in the example above).

For example, you can fit the Art Box on the
existing Trim Box.

fit the current page box to a predefined Librarian
page box size

the Librarian page box size you want to use
("A0", "A1"... in the example above).

Note:

The predefined page
boxes' sizes are
taken from Librarian's
current collection (see
Librarian).

If no collection is
defined, or if it doesn't
contain paper sizes, no
predefined sizes will be
available.

enter the page box's size and position yourself use the Horizontal / Vertical Offset and the
Width / Height fields.

The Size drop-down menu will show "Custom".

9.4.3 Crop Page to Page Box

The “Crop Page to” function in the Document menu allows to crop all objects to the selected page
box. Objects falling completely outside the selected page box will be removed, while objects which
are partially inside the selected page box will get a clipping path.

9.4.4 Apply Page Boxes to All Pages

The Apply Page Boxes to All Pages function in the Document menu, allows to apply the page boxes
of the selected page, on every page of the document. This allows to change the page boxes of a
multipage document on all pages at once.
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9.5 Separations

9.5.1 Document Separations

To simply check the separations for the current document, you can use the View Separations window
in the Window menu (see View Separations Window).

To view and modify the separations for a single page / the whole document, go to the Separations

window (Window/Separations) or click the  button from the Images or Fonts window.

Shortcut: Shift + Command + I (Mac) or Ctrl + Shift + I (Windows).

The separations are shown in the order they will be printed. You can drag and drop them to change
this order. Each separation has a preview color, a name and a type.

Preview Color

This shows the display color of each separation.

Name

This column show the names of the separations.

Type

The type of a separation can be “Standard”, “Opaque”, “Technical” or “Varnish”.

• Standard inks are the common transparent inks, such as CMYK and most Pantones. When
objects are overprinting, the underlying ink will be visible.

• Opaque inks (like gold, white, silver...) are not transparent, so even when overprinting, they will
cover underlying colors completely. The type of their separations should be “Opaque”, in order
to display and proof correctly. This will also affect trapping.
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• Technical inks are separations that are used to color technical lines (such as Die lines, folding
lines, etc.).

• Varnish separations allow to define where varnish needs to be added.

9.5.2 Modify Separation

Change Separation Display Color

Double-click the color rectangle to open the standard Color Picker. Then choose your display color
and click OK.

Change Separation Name

Double-click a separation's name to change it.

Change Separation Type

To change a separation's type, click the double-arrows in the “Type” column.

You can process a separation differently (exclude it from printing for example) by setting its type to
“Technical” or “Varnish” (see Type for more information).

9.5.3 Add Separation

Click the "+" button to add a separation.

In the pop-up window that appears, you can enter a separation name and click OK.

9.5.4 Delete Separation

Click the "-" button to delete the selected separation.

Objects defined only in this separation will not be deleted: they will become white.
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You can retrieve a separation you just deleted with Undo (Command + Z (Mac) or Ctrl + Z (Windows)).

9.5.5 Remap Separation

Click the remap button  to remap the selected separation.

In the pop-up window that appears, you can either remap the selected separation to another
separation, or remap it to CMYK.

To remap it to a single separation, choose a separation in the drop-down menu, or click the “...”
button to choose a separation in the Inks window.

To remap it to CMYK, just click the “CMYK” radio button.

The conversion will be done as soon as you click the “OK” button.

Note:  When remapping separations,
transparencies and overprints can change or be
lost. For example if a spot color object is set
to overprint to CMYK, this overprint is lost when
remapping the spot color to CMYK.

9.5.6 Separations across the Document

To view the separations information for another page, or all pages of the document, click the Show

Pages button .

Click the desired page to display its separations, or double-click the page to display it in the main
window. To view the separations for all pages of the document, click “All Pages”.
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When “All Pages” is selected, you can add, delete or remap separations in all pages of the document
at once.

9.6 Images

9.6.1 Document Images

To view and modify the images information for a single page / the whole document, go to the Images

window (Window/Images) or click the  button from the Separations or Fonts window.

The information is sorted into six columns:

Preview image

This column displays a preview of each image. Click the column header to sort the images back to
front (the image at the very back of the page being shown at the top) or front to back.

Name

This column shows the image file name without the extension, or “Embedded” if the image is
embedded.

If the image appears more than once, a count of appearances is also displayed.

Click an image to select it, or double-click to zoom in on it.
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You can also click the gray triangle to show more information about the image / different occurrences
of the image.

Resolution

This shows the resolution of the images within the document, and not the original resolution of the
images.

If the file contains the same image several times but with different resolutions, the lowest resolution
is shown, after a “>” sign.

Clicking on the gray triangle in the “Name” column shows the resolutions for each occurrence of
the image.

Size

This shows the size of the original image in pixels. When the gray triangle is developed, the size of
each occurence of the image is shown in the unit defined in the Preferences (e.g.: mm).

Color

This shows the color space of the image. If the color space is DeviceN, the number of separations
is shown in brackets.

If the image has an ICC profile, a color management icon  is shown beside the color space.

Type

The file type is shown here (Lossless, Jpeg...).

9.6.2 Attach / Detach ICC Profile

To change an image's profile, click its color space in the “Color” column and select “Profile”. You
can then attach a profile to the image by clicking on the profile name, and detach a profile by clicking
on “None”.
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Note:  You can attach/detach a single ICC profile
for all the images in the same color space (e.g.
CMYK) by clicking on the first image in the list,
holding Shift while clicking on the last image, and
selecting an ICC profile (or “None”) in the list.

This operation only adds a profile information to the image,which is then used for on-screen display
(see also Working Color Spaces),and further processing (e.g.: exporting an image or editing it).

To actually modify the image colors according to a profile, you need to convert the image to this
profile (see Convert Image Color Space).

9.6.3 Convert Image Color Space

In i-cut Preflight, you can also convert an image's color space for final printing.

You can convert any RGB or CMYK image to your chosen profile within the CMYK color space, and
any grayscale image to a profile within the grayscale color space.

The image is converted to a specific profile / Output Intent within the destination color space, with
your chosen rendering intent.

To convert an image's color space, click its current color spacein the “Color” column and select
“Convert”.

In the dialog that pops up, choose the profile to convert the image to in the “to profile” drop-down
menu.

Then select a rendering intent from the bottom drop-down menu, to specify how the image should
be converted, before clicking “OK”.

See Perceptual, Saturation, Relative Colorimetric and Absolute Colorimetric for information about
rendering intents.
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Perceptual

This rendering intent compresses the image gamut into the destination gamut. It modifies all the
colors, but relatively to each other, so it keeps an overall harmony.

This is one of the most commonly used rendering intents, and is mostly used for converting from
RGB to CMYK color space.

Saturation

This rendering intent saturates the in-gamut colors, and converts each out-of-gamut color individually
to the closest in-gamut color. This means that close out-of-gamut colors may be converted to the
same in-gamut color (the image will then lose several shades).

This is the least commonly used rendering intent, and it is mostly used for cartoons / comics, business
graphics, or to improve weak images.

Relative Colorimetric

The “Relative Colorimetric” and the “Absolute Colorimetric” rendering intents treat colors in the same
way, but differ in their treatment of the white point. These rendering intents convert each out-of-
gamut color individually to the closest in-gamut color (like the “Saturation” rendering intent).

However, they don't modify in-gamut colors, which can lead to a visual discrepancy between the
original and the converted image.

“Relative Colorimetric” maps the white point to the destination paper's white (so no ink is used when
printing white).

It is used mostly for limited conversions, such as a CMYK to CMYK conversion. It generally doesn't
give good results when converting images with gradations or blend modes.

Absolute Colorimetric

The “Absolute Colorimetric” rendering intent converts images the same way as the “Relative
Colorimetric” rendering intent.

However, it maps the white point to the white point of the source profile. This means this profile
simulates the source white within the image.

For example if the source profile is designed for a newspaper, its white will be slightly grey, so the
whole image will have a slight grey undertone.

This rendering intent is mostly used for proofing (on-screen or on a proofing device), to reproduce
what the image's appearance will be on the final paper.

If accidentally printed on the final paper with this rendering intent, the image will look dull and darker.

9.6.4 Place Image

To place an image, you can either:

• Click the "+" button at the bottom left of the Images window.
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• Use the Place... function in the Object menu (Object/Image/Place...).

Then browse to the image file you want to place.

It gets placed at the bottom left of the Trim Box, or at the ruler origin if the ruler is shown.

You can place image in the following formats: and in the following color spaces:

• TIFF,
• JPEG,
• PNG,
• (image) PDF,
• PSD,

• CMYK (including CMYK with spot and / or
alpha channels),

• RGB (including RGB with alpha channels),
• LAB (without spot or alpha channels),
• Multichannel or DeviceN (including alpha

channels),
• Indexed,
• Grayscale,
• Monochrome.

Placed images will keep their ICC profile if they have one.

Note:  If the image placed contains channels in
separations (spot colors or CMYK) that do not
exist in i-cut Preflight, these separations will be
added automatically.

9.6.5 Delete Image

Click the "-" button at the bottom of the Images window to delete all occurrences of the selected
image.

9.6.6 Replace Image

The Replace button  in the Images window allows you to replace all occurrences of the selected
image with an image file of your choice.i-cut Preflight remembers the link to this file.

9.6.7 Edit Image

You can edit an image by clicking on the Edit button  at the bottom of the Images window.

This opens the selected image in the default image editor defined in the Preferences (see Editing),
for example Photoshop.

When saving the edited image in the image editor, it will be updated immediately in the i-cut
Preflightfile.
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Note:  This will not alter the original image but save
a copy of the edited image in your PDF file.

You can use the regular Undo function to cancel those changes.

Note:  If the image has a profile attached to it, this
profile will be used as the working color space of
the editing application.

9.6.8 Export Image

i-cut Preflight enables you to export an embedded image as a TIFF file (this saves the image on disk
as a separate file).

The image is embedded if the application that created the PDF didn't include the file path information
(which was the case in i-cut Preflight 1.0).

Once the image is exported to a file, i-cut Preflight remembers the link to this file. You can view this
link in the Paint window, by clicking on the little folder icon beside the image name. See Image.

To export an image, select it in the document, and go to Object/Image/Export... A browse window
will open for you to define the file name and location.

You can also export an image by clicking on the Export button  at the bottom of the Images
window (this works exactly the same way).

Note:  If the exported image has a profile attached
to it, it will be kept in the exported image file.

9.6.9 Images across the Document

By default, the information displayed is relative to the current page.

To view information for another page of the document, click the Show Pages button .

Click the desired page to display its images, or double-click the page to display it in the main window.

To view the images for all pages of the document, click “All Pages”.

When “All Pages” is selected, you can process all occurrences of an image in the whole document
at once (e.g. edit, replace, attach/detach an ICC profile, etc.).
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9.7 Fonts

9.7.1 Document Fonts

To view and modify the fonts information for a single page / the whole document, go to the Fonts

window (Window/Fonts) or click the  button from the Separations or Images window.

Preview

For each font, this column displays one of the font's glyph. This is either the letter “A”, the first letter
of the font's subset if “A” is not included in it, or a unicode translation if the font doesn't contain
an “A” (e.g.: dingbats).

Name

This column displays the full name of each font used. If a font has been embedded by several
applications (e.g.: in TrueType by one, in Type1 by another), its name will be displayed multiple times.

You can click the gray triangle beside the font name to see all paragraphs of text using that font.

Click a font name to select it in the document. If the Type Tool is active this will select the text for
editing, otherwise it will select the text box. Double-click to zoom in on it.

Embedding

This column shows the type of embedding used for each font. This could be “None”, “Subset” or
“Full”.
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• “None” means the font is not embedded in the document. In this case, the text using this font
can only be displayed if the font is available on your system.

• “Subset” means only a subset of the font is embedded. If you are allowed to edit the text (see
below), you will only be able to use characters included in the subset.

• “Full” means the font is fully embedded. If the font license allows you to edit the text, you will be
able to use all the characters of the font.

License

This column shows information about the font's editing permissions.

• “Viewing” means you can only view the text in this font, but not edit it. It you type characters in
this text, they will be in one of your system fonts.

• “Editable” means although you don't have the font in your system, you can edit the text using
the embedded font or subset.

• “System” means the font is installed on your system, so you can edit the text without any
restriction.

• “Unknown” means i-cut Preflight could not determine if you are allowed to edit the text in this
font or not. If you try to edit it, i-cut Preflight will ask you if you have a license for this font. If you
do, you can click “Yes” and start editing the text.

Type

This displays the fonts' type technology, which could be “TrueType”, “Type1”, or “Type3”.

9.7.2 Change Font Embedding

To change a font embedding, select it and click the doublearrows in the “Embedding” column (you
can also select several fontsusing the Shift key and change their embedding at once). In the pop-up
menu, select the embedding of your choice (“None”, “Subset” or “Full”).

Change embedding to “None”

You can always change the embedding to “None”. This will remove the embedded font from the
PDF document.
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Note:  This could cause a visual change to the
document, becausea system font will be used to
view the text. If there is no corresponding system
font on the computer opening the file, missing

glyph symbols( ) will appear instead of the
characters.

Change embedding to “Subset”

You can only change the embedding to “Subset” if the font is entirely embedded in the PDF, or if it
is available as a system font.

Change embedding to “Full”

This is only possible if the font is available as asystem font.

Note:  If the document font and your system font
have the same name but differ slightly (e.g.: by
the width of the glyphs), this could cause a visual
change to the document. You will then be asked
ifyou want to reflow the text inside of the text box.
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Re-subset the font

The font can only be re-subset if it is available in your system. If this is the case, the font will be re-
subset automatically when you type new characters and save the file.

9.7.3 Delete Font

To delete a font, select it and click the "-" button. You can select several fonts to delete using the
Shift key.

9.7.4 Replace Font

To replace a font, select it and click the replace button . In the pop-up window that appears,
choose the new font (and its face if applicable) and click OK.

This will cause the text to reflow inside of the text box.

9.7.5 Fonts across the Document

To view font information for another page of the document, click the Show Pages button .

Click the desired page to display its fonts, or double-click the page to display it in the main window.

To view information for all pages of the document, click “All Pages”. If the same font is used by
several pages of the document, it will appear several times in this view.

When “All Pages” is selected, you can change a font's embedding, delete or replace it, in all pages
at once.

9.8 Flattener

Go to Document/Flatten to use the i-cut Preflight flattener. The flattener allows you to remove some
features from your document (blend modes, overprints, DeviceN color spaces...), so you can save it
in an earlier PDF version (e.g. PDF 1.3). You can also flatten to a newer PDF version (e.g. after adding
features not supported in the file's current PDF version).
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9.8.1 PDF Version

You can choose to flatten your document to:

• PDF 1.3 (this PDF version doesn't support blend modes or layers),
• PDF 1.4 (this PDF version supports blend modes),
• PDF 1.5 (this PDF version supports blend modes and layers),
• PDF 1.6 (this PDF version supports blend modes, layers and JPEG 2000 compression),
• or to keep the current PDF version.

Note:  You can see the PDF version of your
document in the Document window (see Fill Paint /
Stroke Paint).

9.8.2 Flatten non-separable blend modes

Enable this option to flatten Hue, Saturation, Color and Luminosity blend modes. This doesn't flatten
other blend modes unless used with PDF 1.3.

For more information about blend modes, see Blend Modes.

Note:  If you choose to flatten your document to
PDF 1.3, this option is automatically enabled (and
flattens all blend modes).

9.8.3 Split DeviceN color spaces

• Keep this option disabled to preserve DeviceN color spaces.
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• Enable it to split each object in the DeviceN color space into several overprinting objects (e.g.: a
CMYK object and one or several objects in spot color spaces).

9.8.4 Resolve overprints

Enable this option to flatten overprints.

• Flattening 2 overprinting objects with this option off keeps the overprint as it is,

• flattening them with the option on generates 3 objects.

9.8.5 Convert PS blends

PostScript-style blends (or “PS blends”) are blends made of a succession of paths with progressive
variations of size/location and color between them.
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Switch this parameter on to convert PostScript-style blends into images, using the specified
Flattening Resolution. This makes the file simpler and allows faster processing.

9.8.6 Flattening Resolution

Enter the resolution you want to flatten (downsample) images to when completely resampling images
(see Completely resample images).

9.8.7 Completely resample images

If only part of an image needs to be flattened, this flattens the whole image, to avoid creating pixels
problems at the boundaries between the flattened part and the original image.

You can choose the resolution to flatten your image to (see Flattening Resolution).

9.9 Action Lists

With i-cut Preflight, you can run Action Lists on a document.

An Action List is an automated succession of actions that performs a task (e.g. convert all colors
in a document to CMYK).

9.9.1 Running an Action List

To run an Action List, go to Document/Run Action List.

You can choose to:

• use a "Standard" Action List (installed with i-cut Preflight),
• use a "Local" Action List (that you made yourself),
• use an Action List created in an older version of i-cut Preflight or another application.
• browse to an Action List file (“.eal”) using “Choose...”.

If your document contains several pages, you need to decide if you want to run the Action List on:

• all pages of the document,
• the current page only,
• a set of pages that you can define.
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Note:  You can also trial-run an Action List while
creating/editing it. See Test.

Note:  i-cut Preflight will display the 5 last Action
Lists that you used in the Run Action List sub-
menu.

9.9.2 Managing Action Lists

Go to Document/Manage Action Lists... to create, edit or delete Action Lists or Action Lists groups.
This opens the Manage Action Lists window.
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This window shows all Action Lists and Action List groups, organized in a tree structure.

It contains:

• "Standard": Action Lists installed with i-cut Preflight. These Action Lists are not editable.
• "Local": Action Lists you created, and that are only accessible to you. They are saved as ".eal"

files in your Action Lists folder.
• "Action Lists": if you have Action Lists created in a previous version of i-cut Preflight / another

application on your system (called "Global Action Lists"), you will find them here. These Action
Lists are saved as ".eal" files in your Action Lists folder.

Note:  If you have legacy "Local" or "Global"
Action Lists on your system, you will find them in
a "From Old Database" group.

Note:  i-cut Preflight is compatible with the latest
PitStop Pro Action Lists.

New Action List

Click the “New”  button to create a new Action List. You can also click the Action  button
and select “New Action List...”.
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Note:  You cannot add Action Lists in the
"Standard" Action List group.

This opens the Add Action List dialog.

In this dialog, you can add or remove actions from the Action List, and define attributes for certain
actions (e.g. “Fill” or “Stroke” for the “Change Color” action).

Note:  Use the “Show / Hide Library” button 
to show or hide the list of available actions.

Actions Filters

You can use the leftmost panel to filter what actions you see in the list. Click one of the filters to only
show the related actions in the second panel.

You use the following filters:

• "All": all available actions.
• "Recent": actions you have recently added to an Action List.
• "Favorites": actions you have added to your Favorites (see Add To Favorites on page 143).
• action type (Selection-related actions, Check-related actions...),
• action category: actions related to specific elements of the file (e.g. "Image") or general changes

to be made (e.g. "Document" or "Metadata").
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You can also use the search field to display certain actions (for example, type “OPI” in it to display
all OPI-related actions).

Add To Favorites

You can add an action to your Favorites, so you can find it easily next time you define an Action List.

To do this, select it, click the Action  button and choose Add To Favorites.

Note:  To remove an action from your Favorites,
select it in the Favorites category, click the Action
button and choose Remove From Favorites.

Add To Action List

To add an action to your Action List, select it in the actions panel and either:

• double-click it,
• drag it to the second panel,
•

click the  button.

The bottom part of the “Selected Actions” panel will contain all the actions you added to this Action
List.
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Note:

If you add actions in an incorrect order (like in the
picture below), the Add Action List window will
show one or more error icons.

Hover on the icon to get information about the
error.

Grouping Actions in Action Lists

You can group actions in your action list to organize them better.

1.
Click the Add Group  button.

2. Select Action Lists in the left panel and drag them into the group.

Note:  Make sure you drag the actions inside the
group and not after it (they must be indented).

3. If needed, change the name of the group in the "Options" panel at right.

Tip:  You can use the triangle beside the group to
show / hide the group's actions.
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Action List Information

Click “Action List Info” and use the panel on the right to give a name, an author, a company name
and a description to your Action List.

Action List Locking

Click “Locking” and use the panel on the right to define if your Action List should be locked and
how much.

If you select “Partially locked” or “Locked”, you can enter a password for your Action List. Enter it in
the “Password” and “Confirm” fields and click the “Apply” button.
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Action Attributes

Select an action in the Action List panel to display its attributes (if any) in the Attributes panel.

Log

Use this attribute to define whether to log the current action to the Errors & Warnings window. You
can choose:

• “Don't Log”,
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• “Log as Warning”,
• “Log as Error and Allow Sign-Off”.
• “Log as Error”.

For more information on the Errors & Warnings window, see Errors & Warnings.

Test

You can run the Action List from this dialog before saving it (e.g. if you want to test it) using the
Test button.

This brings the document window at the front and runs the Action List on it.

To save your Action List afterwards, go to Window/Edit Action List and click the “OK” button.

Note:  You can run your Action List on any file open
in i-cut Preflight.

Click the “OK” button at the bottom of the window to save your Action List.

Note:  You cannot save a new Action List in the
“Default Action Lists” group. If you created your
Action List in this group, i-cut Preflight will ask you
to save it in the “Local Action List” group instead.

New Group

1.
Click the “New Group”  button to create a new Action List Group.

You can also click the Action  button and select “New Group...”.
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Note:  This creates your new group inside the
group that you selected in the Action Lists tree
structure.

2. Double-click the group you just created (called "Untitled" by default) and give it a name.

You can also right-click it and select "Rename".

Delete Action List / Group

To delete an Action List or a group, select it inthe Manage Action Lists window and click the “Delete”

 button.You can also click the Action  buttonand select “Delete (name)”, or just press
backspace.

This deletes the selected Action List or the selected groupand all the Action Lists it contains from
the Action Lists database.

Edit Action List

Rather than creating totally new Action Lists, you might find easier to create your own Action Lists
based on the predefined Action Lists.

To do this, select the Action List you want to edit in the Manage Action Lists window, click the Action

 button and select “Edit (Action List name)...”.

You can also double-click the Action List in the Manage Action Lists window to edit it.

Note:  If the Action List you want to edit is partially
locked (see Action List Locking), you can either
enter the password to edit it, or choose to only
view it.

This opens the “Edit Action List” dialog.
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This is the same dialog as when you create a new Action List. For more information, see New Action
List.

Note:  Use the “Show / Hide Library” button 
to show or hide the list of available actions.

Duplicate Action List

To duplicate an Action List, select it in the ManageAction Lists window, click the Action  button
and select “Duplicate (Action List name)...”.

Rename Group

To rename a group:

1. right-click it in the Manage Action Lists window,
2. select “Rename”,
3. type the new name.

You can also select the group to rename, click the Action  button and select “Rename (Group
name)”.

Import Action List

You can import a “.eal” file to make the Action List available in the “Manage Action Lists” window
for managing and editing.
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To do this, click the Action  button and select “Import Action List...”. This opens a finder window
where you can select the Action List to import.

Import Group

You can import a folder containing “.eal” files as an Action List group.

To do this, click the Action  button and select “Import Group...”. This opens a finder window
where you can select the folder to import.

Note:  This imports the group inside the group that
you selected in the Action Lists tree structure.

Export Action List / Group

You can export an Action List as a “.eal” file, to transfer or distribute it.

To do this, click the Action  button and select “Export (Action List name)...”. This opens a finder
window where you can define the name and location of the exported “.eal”file.

You can also export a group, as a folder containing “.eal”files.

Click the Action  button and select “Export (group name)...”. This opens a finder window where
you can define the name and location of the exported folder.

Sort Action Lists / Groups

You can select an Action List or a group and drag it up or down in the tree structure.

9.10 Preflighting

With i-cut Preflight, you can preflight your PDF files with preflight profiles. A preflight profile is a
collection of checks and fixes to correct your PDF files and make them print-ready.

For more information about preflight profiles, please see the Enfocus Knowledge Base:

http://www.enfocus.com/kboverview.php

9.10.1 Preflighting a Document with a Preflight Profile

To preflight a document without saving it (e.g. to test a preflight profile you just created), go to
Document/Preflight.

Note:  To preflight your document as part of the
Certification process, use the Save and Preflight
function in the File menu. See Save and Preflight.

You can choose to:

http://www.enfocus.com/kboverview.php
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• use a "Standard" preflight profile (installed with i-cut Preflight),
• use a "Local" preflight profile (that you made yourself),
• use a preflight profile created in an older version of i-cut Preflight or another application (under

"PDF Profiles").
• browse to a preflight profile file (“.ppp”) using “Choose...”.

You then need to decide if you want to preflight all pages of the document, the current page only,
or a set of pages that you can define.

Note:  i-cut Preflight will display the 5 last preflight
profiles that you used in the Preflight sub-menu.
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9.10.2 Managing Preflight Profiles

Go to Document/Manage Preflight Profiles... to create, edit or delete preflight profiles or preflight
profiles groups. This opens the Manage Preflight Profiles window.

This window shows all preflight profiles and preflight profile groups, organized in a tree structure.

It contains:

• "Standard": preflight profiles installed with i-cut Preflight. These profiles are not editable.
• “Local”: preflight profiles you created, and that are only accessible to you. They are saved as

“.ppp” files in your “User/Library/Preferences/Enfocus Prefs Folder/PDF Profiles” folder.
• “PDF Profiles”: if you have preflight profiles / PDF profiles on your system created in a previous

version of i-cut Preflight/ another application (called “Global Preflight Profiles” or “Global PDF
Profiles”), you will find them here.

These profiles are saved as “.ppp” files in your “System/Library/Preferences/Enfocus Prefs
Folder/PDF Profiles” folder.
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Note:  If you have legacy “Local” or “Global”
preflight profiles on your system, you will find them
in a “From Old Database” group.

Note:  i-cut Preflight is compatible with the latest
PitStop Pro Preflight Profiles.

New Preflight Profile

Click the “New”  button to create a new preflight profile. You can also click the Action 
button and select “New Preflight Profile...”.

This opens the “Enfocus Preflight Profile Editor” dialog.

In this dialog, you add information to your profile and define what problem categories it needs to
check and fix.

General

Enter your profile's name, and add optional information like the Author, the Company and a
Description.

Locking

Choose if you want your profile to be unlocked, partially lockedor locked.

When you choose “Partially locked”, you can decide what changes toallow without a password.
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When you choose either “Partially locked” or “Locked”, you havet o enter a password. Users with
this password will be able to make unrestricted changes to the profile.

Processing
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• The “Processing Properties” options allow you to change the profile's behavior for all problem
categories (e.g. disable all fixes).

• The “Pages to show in the preflight report” options allow you to define what information you want
to see in the report.

• The color management options allow you to apply color management when preflighting your
document with your preflight profile. You can choose to color manage all objects the same way
or to color manage images differently.

Problem Categories

Select a problem category in the left panel to display more details in the right panel. Depending on
the category, you can define problems to detect, reporting type and fixes.

Note:  Click the “Enable...” check box at the top of
the right panel to enable checking for this problem
category in the preflight profile.

• “Problems to detect”: define which particular problems you want to detect in this problem
category.

• “Report as”: choose to report a problem encountered in the file either as an Error, a error you
can Sign-Off or a Warning.

i-cut Preflight automatically opens the Errors & Warnings window when it finds such a problem
in the file.

For more information, see Errors & Warnings.
• “Fix this problem”: you can make the preflight profile fix certain problems it detected.

Click the “OK” button at the bottom of the window to save your preflight profile.

New Group

1.
Click the “New Group”  button to create a new preflight profile group.

You can also click the Action  button and select “New Group...”.

Note:  This creates your new group inside the
group that you selected in the preflight profiles
tree structure.

2. Double-click the group you just created (called "Untitled" by default) and give it a name.

You can also right-click it and select "Rename".
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Delete Preflight Profile / Group

To delete a preflight profile or a group, select it in the Manage Preflight Profiles window and click

the “Delete”  button.

You can also click the Action  button and select “Delete (name)”, or just press backspace.

This deletes the selected preflight profile or the selected group and all the preflight profiles it contains
from the preflight profiles database.

Edit Preflight Profile

Rather than creating totally new preflight profiles, you might find it easier to create your own preflight
profiles based on predefined profiles.

To do this:

1. In the Manage Preflight Profiles window, right-click the preflight profile you want to start from and
select "Duplicate".

2.
Select the duplicated profile, click the Action  button and select “Edit (preflight profile
name)...”.

You can also double-click the duplicated profile.

This opens the “Enfocus Preflight Profile Editor” dialog.

This is the same dialog as when you create a new preflight profile. For more information, see New
Preflight Profile.
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Note:

• If the preflight profile you want to edit is partially
locked (see Locking), you can either enter the
password to edit it, or choose to only view it.

• If the preflight profile is password-protected, i-
cut Preflight will ask you to enter a password
before you can edit it.

Duplicate Preflight Profile

To duplicate a preflight profile, select it in the Manage Preflight Profiles window, click the Action 
button and select “Duplicate (preflight profile name)...”.

Rename Group

To rename a group:

1. right-click it in the Manage Preflight Profiles window,
2. select “Rename”,
3. type the new name.

You can also select the group to rename, click the Action  button and select “Rename (group
name)”.
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Import Preflight Profile

You can import a “.ppp” file to make the preflight profile available in the “Manage Preflight Profiles”
window for managing and editing.

To do this, click the Action  button and select “Import Preflight Profile...”. This opens a finder
window where you can select the preflight profile to import.

Import Group

You can import a folder containing “.ppp” files as a preflight profile group. To do this, click the Action

 button and select “Import Group..”. This opens a finder window where you can select the folder
to import.

Note:  This imports the group inside the group that
you selected in the preflight profiles tree structure.

Export Preflight Profile / Group

You can export a preflight profile as a “.ppp” file, to transfer or distribute it.

To do this, click the Action  button and select “Export (preflight profile name)...”. This opens a
finder window where you can define the name and location of the exported “.ppp”file.

You can also export a group, as a folder containing “.ppp” files.

Click the Action  button and select “Export (group name)...”. This opens a finder window where
you can define the name and location of the exported folder.

Sort Preflight Profiles / Groups

You can select a preflight profile or a group and drag it up or down in the tree structure.
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10. Certified PDF

With i-cut Preflight, you can Certify your PDF files. The Certification ensures your PDF files meet high
quality standards. It consists of:

• a file History, that shows all modifications made to the file and who made them.
• an Incremental Save capability, allowing you to roll back to any previous saved state of the file.
• PDF Preflighting, that uses Preflight Profiles to check PDF files for potential problems and to fix

those problems.

Note:  To be Certified, your file needs to have
at least a file History. Incremental Save and
Preflighting are optional.

10.1 History

Go to Window/History to open the History window.

10.1.1 Session Information

In a Certified PDF workflow, a PDF document can go through various editing sessions, done by
various users.

The Session sections show the Certified status (OK  or not OK ) of the document, and Certified
information for each time the file was saved or Certified.

• “User”: this shows the personal information of the user that created the session. This information
is defined in Preferences/User Info: see User Info.
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• “System”: contains the log on name, the network name, and the Ethernet address of the operator
for that session.

• “Application”: the application used to make the changes, and the name, company and key used
for its registration.

• “Times”: shows the start time and end time of the session.
• “Preflight”: shows the profile used to preflight the document.
• “Comment”: shows the comment(s) entered for this session.
• “Actions”: the changes made to the document, either while preflighting (using action lists) or

manually.
• “Active Session”: the active session only contains the actions done on the file since the beginning

of the session. It can be seen as an undo-redo history.

10.1.2 Highlight / Zoom

You can click one of the entries to highlight the object in the Viewing Color set in the Preferences
(see Viewing colors).

This can be an entry in the actions, both in the active session or in an earlier session, or an entry
in the preflight report.

Double-click an entry to zoom in on the appropriate object(s).

10.1.3 Session Rollback

If you have been using Incremental Save on your file (see Incremental Save), you can roll back to the
way the file was when it was saved in a previous session.

You can do this from the History window:

1. Select the session you want to roll back to.

2.
Click the Action button  and choose "Save Snapshot of Session...".

3. Choose the name and location to use and save the snapshot.



10
i-Cut Preflight | 10. Certified PDF | 161

Note:

• By default, the date of the session you chose
is included in the snapshot file name, but you
can give it any name you want.

• The snapshot is a regular (Certified) PDF,
equal to the way the file was in the session
you chose. You can open that file separately
in i-cut Preflight and edit it if desired.

10.1.4 Show / Hide Details

Click the Action button  then Show Details (or Hide Details) to show / hide additional information
for most of the actions, indicating the objects involved.

You can click / double click each of these objects to highlight it / zoom in on it.

10.2 Incremental Save

The Incremental Save function is offered as part of the “Save As” and “Save and Preflight” functions.

See Save As, and Save and Preflight.

When you enable this, all changes will be saved incrementally to enable roll back to the previous
sessions. This means that you can revert to the way the file was when it was saved in a previous
session.

See Session Rollback to know how to roll back.

10.3 Preflighting

10.3.1 Preflight Profiles

With i-cut Preflight, you can preflight your PDF files with preflight profiles. A preflight profile is a
collection of checks and fixes to correct your PDF files and make them print-ready.

For more information about preflight profiles, please see the Enfocus Knowledge Base:

http://www.enfocus.com/kboverview.php

You can also create, edit, duplicate, import, export or delete preflight profiles.

http://www.enfocus.com/kboverview.php
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For more information, see Managing Preflight Profiles.

10.3.2 Preflighting without Saving (Test Preflight)

To check your document against a Preflight Profile without automatically saving its status, or to test
a Preflight Profile you made yourself, use the Document/Preflight function.

For more information, see Preflighting a Document with a Preflight Profile.

10.3.3 Save and Preflight

To save and preflight your current document, go to File/Save and Preflight...

If the file was never saved, a file browser will be presented first. After that, you have several options:

• Incremental save: this saves all changes incrementally, so you can roll back to the previous
sessions.

•
Preflight Profile: Use the  button to choose the Preflight Profile to use for preflighting. By
default, i-cut Preflight suggests the first profile in your Preflight Profile database.

To define a new Preflight Profile, see New Preflight Profile.
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Note:  If your document was already preflighted
with a Preflight Profile, this Preflight Profile will
be shown between angular brackets.

• Session comment: you can enter a comment for the current session.

Click “Save and Preflight” to:

• save your document,
• preflight it with the Preflight Profile you chose,
• add all corrections made by the profile to the document,
• embed the profile into your document,
• start a new session.

Shortcut: Option + Command+ S (Mac) or Ctrl + Alt + S (Windows)

10.3.4 Certified Status

You can see the Certified Status of the document in the tool bar.

Note:  If you don't see the Certified Status
indicator in the tool bar (for example when opening
i-cut Preflight for the first time), you need to add it
(see Customizing the Tool Bar).

Click the indicator to open a status window.
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Unknown

If a yellow icon with a question mark  is shown, the file hasn't been saved with the “Certify”
option yet, so no profile is set.

The status window indicates that no profile is selected. The window contains a “Save and Preflight...”
button.

Error

A red icon with a cross  indicates that either the profile or the document gives an error status.

A profile can give an error status if it doesn't match any profile in the Preflight Profile database. See
Managing Preflight Profiles.

The document can give an error status if:

• errors were encountered during the preflight,
• the file was edited after being Certified (it is then no longer Certified).

The status window contains a “Show Report” button. See Show Report Document.
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OK

A green icon with a tick  indicates that the file is Certified by a profile matching the Preflight
Profile database, and contains no errors.

The status window contains a “Show Report” button. See Show Report Document.
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11. Preparation for i-cut

i-cut Preflight contains a number of functions and tools specific for the collaboration with i-cut Layout
or i-cut Automate.

These allow you to

• Define and edit the cut path
• Add nicks to the cut path
• Add bleed
• Create white underprint

11.1 Adding or changing a Cut Path

In i-cut Preflight you can add or edit a Cut Path, that can be used in i-cut Layout.

You can

• create a cut path on linework, using  Preparation > Cut Path Tools > Create Cut Path .See
Creating a Cut Path

• Use the Trace Path tool to trace the edges of an image to create a cut path. See Trace Cut Path
on page 167

• Make a Cut Path bigger or smaller over an offset distance, using  Preparation > Cut Path Tools
> Offset Cut Path .See Offsetting a cut path

• Make a Cut Path smoother, using  Preparation > Cut Path Tools > Smooth Cut Path .See
Smoothing a Cut Path

•

Add Nicks to a Cut Path, using the Nicks tool . See Adding Nicks to a Cut Path

11.1.1 Creating a Cut Path

1. Select  Preparation > Cut Path Tools > Create Cut Path

The Create Cut Path dialog will open
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2. Define the Separation to be used for the cut path

a) click the color patch to define the color representation for the separation
b) enter the name for the separation. Default is "CUT"

3. Define how the cut path should be created

• on the union of all visible objects. In that case, you can choose to remove all holes from inside
the cut path, by enabling the Remove Holes option.

• on all objects in a specific separation. Use this option when there already is a cut path in the
file, and it is either filled or stroked in a specific separation. After using this option, the original
separation will be removed. You can choose a separation from a dropdown

• on all objects in a specific layer. use this option when there already is a cut path in the file, and
it is put in a separate layer (its color does not matter in this case). The selected layer will be
removed after using this option. You can choose a layer from a dropdown

• on the trim box

4. Define the Offset distance and corners for the cut path. This will offset the cut path in the same
way as the Offset CutPath function. See Offsetting a cut path

5. If your document contains multiple pages, you can also define if you want to create the cut path
on all pages, on the current page, or on a specific set or range of pages.

6. Click Create Cut Path

The cut path is created in a new technical ink with the chosen color and name. It is also put in a
new layer on top of everything else.

11.1.2 Trace Cut Path

The Trace Cut Path tool allows to create a cut path based on the background color of images. It
works best on images with a solid background.
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1.
Select the Trace Cut Path  tool.

The Trace Path settings will pop up at the bottom of the screen, and the cursor will change to
a cross.

Note:  If the current page of the active document doesn't contain any images, you will get an
error message.

2. Click the background color of the image. A marker will indicate where you clicked, and a cut path
is created. If there is a cut path with the same name, it will be overwritten.

Note:  If you clicked the background color, but no cut path can be found for the combination of
the settings and the background color you clicked, a warning will be shown "Tracing the image
gave no result. Check the tracing parameters."

3. As long as the Trace Cut Path tool is active, and a cut path is selected, a gray overlay will show
the cut path, and you can modify the Cut Path:

• Click a different location to recreate the cut path
• Define the name for the Cut Path
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• Click the color patch to select a different color for the representation of the cut path
• Define the Tolerance: this indicates how much a pixel value can deviate from the chosen

background color while still be included as background
• If you want holes to be removed from the cut path, enable Remove Holes. The image

underneath shows the result with (left) and without Remove Holes.

• Set the Remove Small Contours. All small contours, with both dimensions smaller than the
entered value, will be removed.

• Set the Smooth factor to define how much the resulting path will be smoothed. A small smooth
value is recommended, otherwise the resulting path will contain lots of small corners.

11.1.3 Offsetting a cut path

1. Select  Preparation > Cut Path Tools > Offset Cut Path

The Offset Cut Path dialog will open
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2. Select the Cut Path you want to modify in the dropdown list.

3. Define the Offset Distance. A positive distance will change the cut path to the outside, a negative
distance to the inside.

4. Select the Corner shape: rounded, beveled or mitered.

5. If your document contains multiple pages, you can also define if you want to modify the cut path
on all pages, on the current page, or on a specific set or range of pages.

6. Click Offset Cut Path

11.1.4 Smoothing a Cut Path

1. Select  Preparation > Cut Path Tools > Smooth Cut Path

The Smooth Cut Path dialog will open

2. Select the Cut Path you want to modify in the dropdown list.

3. Define the Deviation.The smooth function reduces sharp corners and replaces them by circular
segments. The Deviation defines the radius of these segments.

4. If your document contains multiplepages, you can also define if you want to smooth the cut path
on all pages, on the current page, or on a specific set or range of pages.

5. Click Smooth Cut Path

11.1.5 Adding Nicks to a Cut Path

Nicks are small interruptions in a cut path, to ensure that during or after cutting, the inside parts
remain connected.

In i-cut Preflight you can only define the position of the Nicks. These positions will be picked up by
i-cut Layout or i-cut Automate, where you can also define the size of the Nicks.

You can use the Nicks tool  to

• add a Nick by clicking on any cut path
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• move a Nick by dragging it around the cut path
• move a Nick to another cut path by dragging it onto that cut path
• remove a Nick by dragging it off the cut path

The Nicks will be saved in the PDF file, and will be picked up by i-cut Layout or i-cut Automate.

11.2 Add Bleed

If the graphic contains no information (color) outside of the cut path, you can add bleed in i-cut
Preflight.

1. Select  Preparation > Add Bleed ...

The Add Bleed dialog will open

2. Define if you want to add bleed to all visible objects, or only to the selected objects.

3. Define where bleed needs to be added:

• on the outside of the cut path. In case the file contains more than one cut path, you can select
it from the dropdown

• outside of the trim box

4. Define the Bleed Distance and corners for the bleed.

5. Define the Clone From distance. In normal circumstances, the color just on the inside of the cut
path is cloned to fill the bleed area. However, in case of a small misregistration of the graphics
inside the cut path and the cut path itself, it could happen that the area just on the inside of the
cut path is white. To prevent from cloning such a white area, the Clone from distance can be used
to go a little bit to the inside of the cut path, and start cloning from that point.
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6. If your document contains multiple pages, you can also define if you want to add bleed on all
pages, on the current page, or on a specific set or range of pages.

7. Click Add Bleed

The bleed will be added in a separate layer on top of the job.

11.3 Create White Underprint

With i-cut Preflight you can create a white background, useful when printing on transparent or metal
material. The White Underprint area has the same shape but a different size than the object under
which it is printed.

1. Select  Preparation > Create White Underprint

The Create White Underprint dialog will open

2. Define the Separation to be used for the White Underprint

a) click the color patch to define the color representation for the separation
b) enter the name for the separation. Default is "White"

3. Define how the White Underprint should be created

• on the union of all visible objects
• on the union of all selected objects

4. Define the Offset distance and corners for the White Underprint. This will offset the White
Underprint in the same way as the OffsetCut Path function. See Offsetting a cut path

5. If your document contains multiple pages, you can also define if you want to create the White
Underprint on all pages, on the current page, or on a specific set or range of pages.

6. Click Create White Underprint

The White Underprint ink is of type 'white' and it is inserted as the very first ink. The underprint object
is added (in overprint) in a separate layer on top of all the content.
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12. Advanced

12.1 Preferences

The Preferences can be opened from the i-cut Preflight menu, or by its shortcut:

Shortcut: Command + , (comma) (Mac) or Ctrl + , (comma) (Windows).

12.1.1 Viewing

Smoothing

This option enables anti-aliasing for all line art, text and images. It is enabled by default, and should
only be disabled if there is a performance problem.

Page box colors

Click a color rectangle to change the display color of the corresponding page box.
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Defining or changing Page Boxes is done by the Page Box Tool (see Page Box Tool) or in the Page
Box window (see View Page Boxes Window).

Editing colors

Click the rectangle to change the selection color, using the Color Picker.

Viewing colors

Click the rectangle to change the highlight color, using the Color Picker.

The highlight color will be used when double-clicking an entry in the History, to highlight the object(s).
See History.

12.1.2 Editing
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Selection mode

You can set the default selection mode to “Outline” select or “Area” select. You can always toggle
the selection mode by using the Option + Command (Mac) or Ctrl + Alt (Windows) shortcut.

See Select for more informations on Selection.

General Units

Changes the units in the complete program, except for text and strokes (see Text units). You can
choose between: mm, cm, m, inch, point, mil, pica points, didot points, Q's, Bai's. (Q and Bai are
Japanese units for character pointsize).

Text units

Units for all text related values. You can choose between: mm, cm, m, inch, point, mil, pica points,
didot points, Q's, Bai's.

Stroke units

Units for all stroke related values. You can choose between: mm, cm, m, inch, point, mil, pica points,
didot points, Q's, Bai's.

Constrain angle

This angle is used by several tools. When rotating an object, the rotation angle will be constrained
(Shift) or will snap (Command) to a multiple of the constrain angle.

This allows you for example to rotate objects by exactly 90°.

Step distance

Enter the distance you want to use when using the Transform Tool with the arrow keys. The default
step distance is 10mm.

For more information see Moving by Step Distance.

Image editor

The Image editor allows to define what application to open when images need to be edited, for
example when double-clicking the preview in the Fill Paint window (see Fill Paint / Stroke Paint).

If no application is set, the default application for the specific file type will be opened (the same
application that would be opened by double-clicking the image in the Finder).

When clicking the “...” button, a browse window will open, allowing to select an application. Clicking
the cross button will remove the application selected previously.
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Working Color Spaces

With those two drop-down menus, you can define the default RGB and CMYK working color spaces
in i-cut Preflight. They are used to display respectively RGB and CMYK images with a “printed”
CMYK rendering on screen.

These working color spaces are only activated if an image has no ICC profile, and the document
has no Output Intent. If a profile is attached to an image or the document, this profile will be used
as working color space.

For information on how to attach a profile to an image, see Attach / Detach ICC Profile.

Color Conversion

Engine

Choose the color management engine that i-cut Preflight will use to convert images' color spaces.
You can choose Apple ColorSync or Little CMS.

See Convert Image Color Space for information on how to convert an image's color space.

Use black point compensation

You can use black point compensation to preserve details in the shadows when converting RGB
images to CMYK colors.

Without black point compensation, several out-of-gamut dark RGB colors may be converted to the
same color, resulting in a loss of detail.

Black point compensation preserves the relationship between those dark colors in the converted
image, resulting in more detail in the shadows.

Note:  You can only use black point compensation
with the Little CMS conversion engine.

12.1.3 Certified PDF
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Always enable Certified PDF

When this option is on, all files will include Certified PDF information when saved. You still have the
option to exclude the Certified PDF information again when using “Save As”.

When opening PDF files that do not contain Certified PDF information, you will get a message asking
you to preflight the file.

12.1.4 User Info

The user's name, company, street, city, state, zip code, country, phone, fax, e-mail and message can
all be entered here. This information is used each time a new session is started in a Certified PDF.
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The User Name is set as the “Author” when a new PDF file is created.

12.1.5 Advanced

Make Backup on Save

Check this box if you want i-cut Preflight to automatically create a backup of your PDF every time
you save it.

i-cut Preflight will save the backup file in the same folder as your original PDF, and add “ Backup” to its
name. For example, a backup for “Summer Berry.pdf” would be called “Summer Berry Backup.pdf”.

12.2 Shuttle

The Shuttle functionality in i-cut Preflight allows you to submit files to / open files from Esko
workflows: Odystar, Nexus and Automation Engine.

• Odystar is a highly automated PDF based prepress workflow solution.
• Nexus is a comprehensive high-end workflow solution for label and packaging environments.
• Automation Engine is a modular workflow server that ensures increased efficiency and throughput

for print professionals.

For more information, go to http://www.esko.com.

• On the Odystar side, you need to run the Hub application and enable Shuttle in the Receive
Gateway. See the Odystar documentation for detailed information.

• On the Nexus side, you need to run the NexusSOAPServer. See the Nexus documentation for
detailed information.

• On the Automation Engine side, you need to setup the Shuttle connection in the Configure tool.
See the Automation Engine documentation for detailed information.

12.2.1 Connecting i-cut Preflight's Shuttle to Workflow Servers

You can connect i-cut Preflight's Shuttle to several EskoArtwork workflow servers. To do this:

1. Go to the Advanced tab of the i-cut Preflight Preferences window.

2. Click the "+" button at the bottom of the Servers list.

http://www.esko.com
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This opens the following pop-up:

3. Enter your User Name and Password (your system user name is filled in by default).

• When connecting to an Automation Engine server, enter the User Name and Password you
use to login to the Pilot (the password can be blank if your server is configured to accept this).

You will have the same access rights (for example, the right to set processing priorities or not)
in Shuttle as you have in the Pilot.

• When connecting to a Nexus server, enter the User Name and Password you use to login to
the NexusManager if your Nexus server has User Management enabled.

You will be able to access the same workflows as from NexusManager.

Note:  If User Management is not enabled, you
will be able to access any workflow on your
server. In this case, you can enter any user
name you like (without a password): it will only
be used for filtering files in the Shuttle window.

• When connecting to an Odystar server, you will be able to access any workflow on your server.
You can enter any user name you like (without a password): it will only be used for filtering
files in the Shuttle window.

Note:  If you don't know which User Name
and Password to use, contact your system
administrator.

4. To connect to a server broadcasting over the Bonjour network (Odystar servers or Bonjour-
enabled Nexus servers):
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a) select Bonjour in the Browse Method list,
b) select your server's name in the Bonjour list.

Note:  You don't have to enter the server
address and server port manually.

5. To connect to a server not broadcasting over the Bonjour network (Automation Engine servers or
non-Bonjour-enabled Nexus servers):

a) select Manual in the Browse Method list,
b) enter your server's name or IP address in Server Address,
c) fill in the Server Port used by your server.

Note:

When connecting to an Odystar server, enter
the port used for SOAP communication
between Shuttle and your Odystar Hub.

When connecting to a Nexus server, enter the
Listening Port of the NexusSOAPServer.

When connecting to an Automation Engine
server, enter the port you defined in Configure.

See the Shuttle manual for more information.

6. Click the Add button.

This adds a connection to your server in the Servers list.

• To remove the connection to a server, select it in the Servers list and click the "-" button.
• To check or edit a server's settings, double-click it in the Servers list.

12.2.2 Filter on Workflow Type

If you connect to several servers or to a server with many canvases or workflows, you may want to
only display certain canvases / workflows when submitting files from i-cut Preflight's Shuttle.

1. In the Advanced tab of the Preferences dialog, enable Filter On Workflow Type.

2.
At the bottom of the Workflow Types To Show list, click the  button and enter the workflow
type you want to show in the Launch window.

• For Odystar canvases, you need to define workflow types in the Receive Process Folders’
parameters. See the Odystar documentation.

• For Nexus workflows, the workflow type is the name of the workflow.

The workflow name format to use here doesn't depend on what you have set in the Workflow
Name Format parameter in the General Preferences. It is always [hotfolder name]@[workflow
name].

• For Automation Engine workflows, the workflow type is the file type that the workflow accepts
as input.
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3.
Click the  button again if you want to add more workflow types to the list.

To remove a workflow type from the Workflow Types To Show list, select it and click the 
button.

12.2.3 Submitting Files to a Workflow

Once you have defined a connection between i-cut Preflight's Shuttle and your workflow server(s),
you can submit files to your workflow(s).

1. Go to  File > Launch Workflow...

This opens the Launch Workflow window.

2. Select the workflow you want to launch on your file in the workflow list.

3. If your workflow has public parameters, you can fill them in the same window.

For more information on public parameters, see the Shuttle manual.

Note:  If you want to go back to the default
parameters values after changing them, use the
Reset To Defaults button.

4. Click Launch to launch the workflow on your file.
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Editing a File in a Workflow and Resubmitting it

You can use i-cut Preflight to edit a file being processed by a workflow.

1. Pause the processing of the file in the Shuttle window.
2. Open the file in i-cut Preflight (right-click it in the list and choose Open).
3. Edit it as desired.
4. Save it. This automatically resubmits it to the workflow.

Resubmitting a File with the Same (Public) Parameters

If:

• you have set up the Parameter Assistant on your Odystar or Nexus server,
• you have submitted a file to one of that server's workflows using public parameters,

you can resubmit that file to the same workflow queue using the same public parameters, without
having to enter them again.

Note:  For more information about setting up
the Parameter Assistant on your workflow server,
please see the Shuttle manual.

When resubmitting the file to the same workflow queue (containing public parameters), the Launch
Workflow dialog contains a "Use Previous" button.
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Click this button to reuse the same public parameters for this file.

12.2.4 Shuttle Window

The Shuttle window shows all files belonging to you or to all users, in all workflows your Shuttle is
connected to.

Go to Window/Shuttle to open the Shuttle window.

Tip:  You can resize the window to see more
information if needed.

The Shuttle window shows each file's name, status, the workflow the file is in, etc.

From that window, you can:

• check your file's processing in the workflow,
•

hold , release , delete  or abort  the processing of a file,
• filter the file's list to see only certain files,
•

see only your files  or everybody's files ,
•

see more information in the Inspector panel (click ).

See the Shuttle manual for more details.
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Note:

You can see the number of files requiring attention
(that you need to route in the workflow) on the
Shuttle icon in the tool bar.

Clicking the icon opens the Shuttle window.

To add the Shuttle icon to the tool bar, see
Customizing the Tool Bar.
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